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RUKUN NEGARA  
Bahawasanya Negara Kita Malaysia 

mendukung cita-cita hendak; 
 

Mencapai perpaduan yang lebih erat dalam kalangan                                  
seluruh masyarakatnya; 

 

Memelihara satu cara hidup demokrasi; 
 

Mencipta satu masyarakat yang adil di mana kemakmuran negara            
akan dapat dinikmati bersama secara adil dan saksama; 

 

Menjamin satu cara yang liberal terhadap                                                     
tradisi-tradisi kebudayaannya yang kaya dan pelbagai corak; 

 

Membina satu masyarakat progresif yang akan menggunakan  
sains dan teknologi moden; 

 

MAKA KAMI, rakyat Malaysia,  
berikrar akan menumpukan  

seluruh tenaga dan usaha kami untuk mencapai cita-cita tersebut 
berdasarkan prinsip-prinsip yang berikut: 

 

KEPERCAYAAN KEPADA TUHAN 
KESETIAAN KEPADA RAJA DAN NEGARA 

KELUHURAN PERLEMBAGAAN 
KEDAULATAN UNDANG-UNDANG 
KESOPANAN DAN KESUSILAAN 

 
 
 

  (Sumber: Jabatan Penerangan, Kementerian Komunikasi dan Multimedia Malaysia) 
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Assalamualaikum Warahmatullahi Wabarakatuh dan Salam Sejahtera. 

 

Syukur ke hadrat Ilahi kerana dengan izin-Nya Modul Pembelajaran Kurikulum Standard Sekolah 

Menengah (KSSM) Mata Pelajaran Vokasional (MPV) Tingkatan 5 dapat disempurnakan 

penerbitannya. 

Dalam menangani hala tuju serta pembangunan dunia pendidikan hari ini, Bahagian Sumber dan 

Teknologi Pendidikan (BSTP), Kementerian Pendidikan Malaysia berusaha menyediakan bahan 

pembelajaran ini sebagai satu dokumen sumber rujukan utama para murid dan guru MPV yang 

dapat memenuhi keperluan semasa dalam bidang pendidikan kemahiran vokasional.  

 

Modul pembelajaran ini dibina berasaskan kandungan Dokumen Standard Kurikulum dan 

Pentaksiran (DSKP) bagi membantu murid menguasai bidang pengetahuan dan kemahiran yang 

berkaitan di samping dapat melahirkan insan yang produktif serta seimbang dari segi intelek, 

rohani, emosi dan jasmani. Bagi merealisasikan hasrat ini, 

bahan pembelajaran ini juga menjadi panduan kepada guru dalam melaksanakan pengajaran dan 

pembelajaran (PdP) yang berkesan. 

  

BSTP amat menghargai segala idea dan usaha yang telah digembleng 

bersama semasa menerbitkan modul pembelajaran ini. Setiap kejayaaan dasar pendidikan dan 

program yang menyokong dasar tersebut hendaklah dilaksanakan 

dengan kefahaman dan kerjasama yang kukuh daripada semua pihak terutamanya warga 

pendidik. Semoga usaha murni ini dapat mencapai objektif dan matlamat yang diharapkan. BSTP 

berharap agar bahan pembelajaran ini dapat menjadi antara sumber rujukan dan panduan penting 

bagi menentukan garis utama hala tuju pendidikan di Malaysia. 

  

Akhir kata , BSTP mengambil kesempatan ini untuk mengucapkan syabas dan setinggi- tinggi 

tahniah dan jutaan terima kasih kepada panel penulis, panel kawalan mutu, Pejabat Pendidikan 

Daerah (PPD), Jabatan Pendidikan Negeri (JPN), pegawai mata pelajaran Bahagian Pendidikan 

dan Latihan Teknikal Vokasional (BPLTV), pegawai BSTP dan juga semua pihak yang 

telah bekerjasama menjayakan penerbitan bahan pembelajaran MPV ini. 

  

Sekian, terima kasih. 

 

Pengarah 

Bahagian Sumber dan Teknologi Pendidikan 

Kementerian Pendidikan Malaysia 
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MODUL 5.1 

 

Standard 

kandungan  

: 5.1 Identiti Korporat 

Standard 

pembelajaran  

: 5.1.1 Menyatakan definisi identiti korporat. 

5.1.2 Menerangkan kepentingan logo dalam identiti 

korporat.  

5.1.3 Melakar logo: 

(i) Pictorialmarks 

(ii) Wordmarks 

(iii) Combination 

5.1.4 Menghasilkan reka bentuk logo yang bersesuaian 

dengan identiti korporat dengan menggunakan 

perisian grafik. 

5.1.5 Menghasilkan rekaan identiti korporat 

menggunakan logo yang telah dipilih. 

Objektif 

pembelajaran 

:  Mentakrif definisi identiti korporat. 

 Mentakrif definisi logo. 

 Menyatakan fungsi logo. 

 Menyenaraikan 5 kepentingan logo dalam identiti 

korporat. 

 Melakar 3 logo mengikut jenis yang ditetapkan. 

 Menghasilkan 1 reka bentuk logo yang bersesuaian 

dengan identiti korporat dengan menggunakan 

perisian grafik. 

 Menghasilkan 1 rekaan identiti korporat 

menggunakan logo yang telah dipilih. 

Masa : 40 jam 
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NOTA RUJUKAN 

 

5.1 IDENTITI KORPORAT 

PENGENALAN 

Setiap perniagaan atau syarikat haruslah mempunyai identiti korporat yang 

tersendiri bagi membina asas yang kukuh untuk perniagaan mereka. 

Kebanyakan usahawan berjaya di dunia kebiasaannya mempunyai identiti 

korporat mereka sendiri untuk berkomunikasi dengan pelanggan. 

Identiti korporat bukan sekadar logo dan nama yang digunakan sebagai satu 

komponen komunikasi untuk menerangkan identiti sesebuah syarikat. Identiti 

korporat juga melibatkan konsep dan tema yang disasarkan oleh syarikat bagi 

menunjukkan perbezaan dengan pesaing. 

 

5.1.1 DEFINISI IDENTITI KORPORAT 

Identiti korporat boleh didefinisikan sebagai identiti visual sesebuah syarikat, 

organisasi atau institusi sebagai tanda pengenalan yang meliputi nama, latar 

belakang, servis dan pengeluaran produk. 

 

5.1.2 MENERANGKAN KEPENTINGAN LOGO DALAM IDENTITI KORPORAT 

Sebilangan besar pemilik perniagaan percaya bahawa identiti korporat hanya 

memerlukan logo yang dapat dikenali bagi mewakili kualiti dan nilai organisasi 

perniagaan mereka sedangkan sebenarnya identiti korporat yang kuat 

membantu setiap organisasi menyampaikan keperibadian dan nilainya. 

 

Contoh logo identiti korporat 
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A. DEFINISI LOGO 

Logo merupakan elemen grafik yang dilengkapi dengan muka taip dan 

direka bentuk sebagai lambang identiti pengenalan firma perniagaan, 

kelab, persatuan atau organisasi supaya syarikat atau jenama yang 

diwakilinya mudah dikenal pasti.  

 

B. FUNGSI LOGO 

 

     Peta minda kepentingan logo dalam identiti korporat 

 

 

 

 

 

 

 

 

 

 

 

  
Peranan 

Logo 

 

Memudahkan 
para 
pelanggan 
mengenali 
produk atau 
perkhidmatan 

 
Meyakinkan 
pelanggan 

 Meningkatkan 
jualan   

Mengekalkan 
ingatan 
jenama 
perniagaan 
kepada 
pelanggan 

Sila imbas Kod QR 

Kepentingan logo 

dalam identiti korporat,  
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C. JENIS - JENIS LOGO 

i. PICTORIALMARKS 

Ikon atau logo berasaskan grafik seperti gambar yang terlintas dalam 

fikiran ketika memikirkan logo antaranya logo Apple yang ikonik, burung 

Twitter, Target bullseye. Setiap logo syarikat ini begitu simbolik dan setiap 

jenama begitu mantap sehingga tanda itu sendiri dapat dikenali dengan 

serta-merta.  

Pictorialmarks sebenarnya hanyalah gambar. Oleh sebab itu, 

pictorialmarks boleh menjadi jenis logo yang rumit untuk digunakan oleh 

syarikat baharu, atau syarikat tanpa pengiktirafan jenama yang kuat. 

       

Contoh logo pictorialmarks 

 

ii. WORDMARKS  

Logo berasaskan fon yang hanya menumpukan nama perniagaan 

seperti Google, Visa dan Coca-Cola. Wordmarks berfungsi dengan baik 

apabila sebuah syarikat mempunyai nama ringkas dan berbeza yang 

dapat membantu mewujudkan pengenalan jenama yang kuat.   

 

       

Contoh logo wordmarks 
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iii. COMBINATION 

Tanda gabungan adalah logo yang terdiri daripada gabungan kata atau 

tanda huruf dan tanda bergambar, tanda abstrak, atau maskot. Gambar 

dan teks dapat disusun secara berdampingan, diletakkan di atas satu 

sama lain atau digabungkan bersama untuk membuat gambar. 

Beberapa logo tanda gabungan yang terkenal termasuk Doritos, Burger 

King dan Lacoste. 

       

Contoh logo tanda kombinasi 
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5.1.3 MELAKAR LOGO 

Contoh lakaran yang dihasilkan mengikut jenis logo antaranya ialah: 

A. Pictorialmarks 

 

 

(gambar sumber ilham) 

 

                          

 

 

Contoh lakaran Pictorialmarks 

 

B. Wordmarks 
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Contoh lakaran Wordmarks 

 

C. Combination 

 

Contoh lakaran Combination 
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5.1.4 MENGHASILKAN REKA BENTUK LOGO YANG BERSESUAIAN DENGAN IDENTITI 

KORPORAT DENGAN MENGGUNAKAN PERISIAN GRAFIK 

 

PROSES MENGHASILKAN LOGO 

A. Sumber ilham 

Proses awal yang perlu dilakukan ialah mengumpul imej atau logo sedia ada 

yang berkaitan dengan tema. Contoh tema di bawah adalah logo 

perniagaan bakeri. 

 

 
sumber: 

depositphotos.com 

 

Sumber: 

melskitchencafe.com 

 
sumber:     

khasiat.co.id 

   

 

Sumber: 

bakingamoment.com 

 

Sumber: 

melskitchencafe.com 

 
sumber: 

depositphotos.com 
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B. Melakar logo berdasarkan olahan idea 

i. Lakaran kecil 

 

Lakaran kecil mengandungi sekurang-kurangnya 6 lakaran berdasarkan 

sumber ilham 

 

ii. Lakaran kasar 

 

Lakaran kasar diperhalusi daripada pilihan lakaran kecil 
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iii. Lakaran komprehensif 

 

Lakaran komprehensif diperhalusi daripada lakaran kasar dengan 

memasukkan warna pada lakaran 

 

C. Melukis logo menggunakan perisian grafik 

i. Lakaran komprehensif akan diimbas menggunakan pengimbas untuk 

mendapat imej secara digital. 

ii. Imej imbasan akan disisip masuk ke dalam dokumen. 
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iii. Imej tersebut seterusnya akan disurih menggunakan perisian suntingan 

imej vektor. 

 

 

iv. Ilustrasi yang telah disurih akan diwarnakan mengikut kesesuaian tema. 

 

 

 



13 
 

v. Olahan imej dilakukan dengan membuat tetapan warna dan saiz muka 

taip pada rekaan logo.  

 

 

D. Mencetak logo 

Proses akhir sebelum logo ini digunakan pada identiti korporat serta produk, 

logo akan dicetak mengikut spesifikasi yang ditetapkan seperti yang berikut: 

i. Jenis cetakan 

 

ii. Saiz cetakan 
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Tetapan skala 100% 

Tetapan skala 50% 

Tetapan skala 30% 
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5.1.5 Menghasilkan rekaan identiti korporat menggunakan logo yang telah 

dipilih 

 

REKAAN IDENTITI KORPORAT 

Identiti korporat digunakan sebagai satu komponen komunikasi dalam 

menerangkan identiti sesebuah syarikat atau agensi. Identiti ini melibatkan 

konsep dan tema yang disasarkan bagi menunjukkan ketidaksamaan identiti 

dengan pesaing lain.  

Dalam penghasilan identiti korporat, logo akan dijadikan rujukan utama untuk 

melakukan proses pemilihan elemen warna dan rupa illustrasi sebagai motif 

identiti korporat.  

Selain itu, muka taip yang digunakan juga dapat membantu dalam pemilihan 

tipografi yang seragam. 

Antara identiti korporat yang boleh dihasilkan melalui contoh perusahaan bakeri 

(Jaya Bakti Bakery) adalah seperti rekaan kad perniagaan, rekaan kepala surat, 

rekaan kemeja T, rekaan pembungkusan kertas, rekaan label botol minuman dan 

rekaan apron. 

 

 

 

Kad perniagaan  Rekaan kepala surat 
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Rekaan kemeja T  Rekaan pembungkusan kertas 

   

 

 

 

Rekaan label botol minuman  Rekaan apron 
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AKTIVITI 

 

BAHAN DAN PERALATAN  

1. Kertas lukisan 

2. Pensel, pemadam dan pembaris 

3. Pensel warna 

 

TUGASAN 1 

Murid diminta untuk melakar 3 jenis logo yang telah mereka 

pelajari di dalam pembelajaran yang lepas. Murid melakar logo 

berdasarkan tema yang diberikan oleh guru.  

 

 

LANGKAH KERJA (TUGASAN 1) 

1. Murid meneroka ilham masing-masing berdasarkan tema yang diberikan 

oleh guru. 

2. Murid membuat lakaran logo berdasarkan ilham dan perkembangan idea 

(lakaran kasar). 

3. Murid melakar 3 jenis logo pictorialmarks, wordmarks dan combination di 

atas kertas lukisan yang telah diberikan. 

 

Anda kreatif? 

Buat kajian lapangan untuk menghasilkan beberapa lagi jenis 

logo berdasarkan: 

 

(i) Emblem 

(ii) Maskot 
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BAHAN DAN PERALATAN  

1. Perisan imej vektor 

2. Kertas lukisan 

3. Pengimbas dan pencetak 

 

TUGASAN 2 

Murid diminta untuk menghasilkan satu logo berdasarkan tema 

yang diberikan oleh guru. Murid perlu menghasilkan logo 

berdasarkan proses yang telah dipelajari di dalam pembelajaran 

lepas. 

 

 

LANGKAH KERJA (TUGASAN 2) 

1 Murid meneroka mencari ilham berdasarkan tema yang diberikan oleh guru. 

2 Murid membuat lakaran berdasarkan ilham yang telah dicari (lakaran kecil, 

lakaran kasar dan lakaran komprehensif). 

3 Murid memindahkan lakaran komprehensif kepada bentuk softcopy. 

4 Murid membuat surihan imej menggunakan perisian imej vektor.  

Murid membuat cetakan berdasarkan spesifikasi yang telah dipelajari. 

 

Anda kreatif? 

Buat kajian lapangan untuk menghasilkan beberapa lagi jenis 

logo berdasarkan 

 

(i) Pictorialmarks 

(ii) Wordmarks   
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LATIHAN / PENILAIAN 

 

Jawab semua soalan. 

1. Berikan definisi bagi identiti korporat. 

……………………………………………......................................................................

................................................................................................................................... 

 

2. Berikan definisi bagi logo. 

……………………………………………......................................................................

................................................................................................................................... 

 

3. Berikan fungsi bagi logo. 

……………………………………………......................................................................

................................................................................................................................... 

 

4. Senaraikan 5 kepentingan identiti korporat. 

i. ……………………………………………........................................................ 

ii. ..................................................................................................................... 

iii. ..................................................................................................................... 

iv. ..................................................................................................................... 

v. ..................................................................................................................... 

 

5. Senaraikan 3 contoh jenis logo yang telah dipelajari. 

i. …………………………………………….. 

ii. …………………………………………….. 

iii. …………………………………………….. 
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6. Senaraikan 4 proses penghasilan logo. 

i. …………………………………………….. 

ii. …………………………………………….. 

iii. …………………………………………….. 

iv. …………………………………………….. 

 

7. Senaraikan 4 contoh identiti korporat yang boleh menggunakan logo. 

i. …………………………………………….. 

ii. …………………………………………….. 

iii. …………………………………………….. 

iv. …………………………………………….. 

 

8. Mengapakah perlunya penambahbaikan di dalam proses penghasilan 

logo? 

……………………………………………………………………………………………. 

……………………………………………………………………………………………. 

……………………………………………………………………………………………. 

 

9. Senaraikan 2 jenis cetakan yang perlu dihasilkan untuk menyemak kualiti 

logo yang dihasilkan. 

i. …………………………………………….. 

ii. …………………………………………….. 
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LAPORAN PENCAPAIAN MURID 

 

Nama Murid  

Tahun  

Kelas   

 
Standard 

Kandungan 

5.1     Identiti Korporat 

Standard 

Pembelajaran 

5.1.6 Menyatakan definisi identiti korporat. 

5.1.7 Menerangkan kepentingan logo dalam identiti korporat.  

5.1.8 Melakar logo: 

(i) Pictorialmarks 

(ii) Wordmarks 

(iii) Combination 

5.1.9 Menghasilkan reka bentuk logo yang bersesuaian 

dengan identiti korporat dengan menggunakan perisian 

grafik. 

5.1.10 Menghasilkan rekaan identiti korporat menggunakan 

logo yang telah dipilih. 

 

Bil Perkara yang dinilai 

Pencapaian 

Catatan 
Terampil 

Belum 

Terampil 

1 Mentakrif definisi identiti korporat.    

2 Mentakrif definisi logo.    

3 Menyatakan fungsi logo.    

4 Menyenaraikan 5 kepentingan logo dalam 

identiti korporat. 
  

 

5 Melakar 3 logo mengikut jenis yang 

ditetapkan. 
  

 

6 Menghasilkan 1 reka bentuk logo yang 

bersesuaian dengan identiti korporat 

dengan menggunakan perisian grafik. 

  

 

7 Menghasilkan 1 rekaan identiti korporat 

menggunakan logo yang telah dipilih. 
  

 

KEPUTUSAN 
(CAPAI / TIDAK CAPAI) 

TARIKH 

 

Nama Guru  Tandatangan & Tarikh  

Disahkan oleh  Tandatangan & Tarikh  

 



22 
 

MODUL 5.2 

Standard 

kandungan 

: 5.2 Pengiklanan 

Standard 

pembelajaran  

: 5.2.1 Menyatakan maksud pengiklanan 

5.2.2 Menjelaskan kepentingan reka bentuk pengiklanan 

5.2.3 Membanding beza kaedah pengiklanan menerusi 

media: 

i. Cetak 

ii. Elektronik 

5.2.4 Menyesuaikan keperluan bahan promosi dalam 

pengiklanan seperti: 

i. Gegantung  

ii. Kain rentang  

iii. Risalah  

iv. Poster  

v. Iklan interaktif  

5.2.5 Menghasilkan reka bentuk bahan promosi dengan 

mengaplikasikan ciri pengiklanan yang baik dengan 

menggunakan perisian grafik 

5.2.6 Menghasilkan bahan promosi untuk tujuan 

pengiklanan 

Objektif 

pembelajaran 

: ▪ Mentakrif definisi pengiklanan 

▪ Menyenaraikan kepentingan reka bentuk pengiklanan 

▪ Menyatakan perbezaan kaedah pengiklanan 

menerusi media cetak dan elektronik 

▪ Menyatakan keperluan bahan promosi dalam 

pengiklanan seperti gegantung, kain rentang, risalah, 

poster dan iklan interaktif 

▪ Menghasilkan reka bentuk bahan promosi dengan 

mengaplikasikan ciri pengiklanan yang baik dengan 

menggunakan perisian grafik 

▪ Menghasilkan bahan promosi untuk tujuan 

pengiklanan 

 

Masa : 28 jam 
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NOTA RUJUKAN 

5.2 PENGIKLANAN 

 

5.2.1 MENYATAKAN MAKSUD PENGIKLANAN 

DEFINISI PENGIKLANAN 

 

 

Contoh iklan yang menggunakan media cetak dan elektronik 

 

 

Pemberitahuan kepada orang 
ramai segala bentuk pesanan 
tentang sesuatu produk yang 
disampaikan melalui media 
percetakan mahupun 
elektronik dan dibiayai oleh 
syarikat serta ditujukan kepada 
masyarakat umum. 

Dewan Bahasa dan             
Pustaka 

 

Komunikasi melalui media yang 
dibayar oleh syarikat, organisasi 

dan individu-individu dengan 
menggunakan iklan yang dapat 

memberi informasi kepada 
orang ramai. 

George Rodman, 2012, 

Mass Media 

 

Sebarang bentuk          
persembahan atau            
komunikasi berbayar,  
bersifat tidak peribadi, yang 
ditujukan kepada kumpulan 
sasaran dengan tujuan untuk 
mempromosi, memperkenal dan 
meningkatkan atau melariskan 
jualan sesuatu produk, 
perkhidmatan ataupun idea oleh 
penaja yang dikenal pasti. 

 

Bentuk komunikasi 
 bukan personal yang digunakan 

oleh penaja untuk memaklumkan  
bakal pembeli mengenai sesuatu 

produk. 

 Pengiklanan 
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5.2.2 KEPENTINGAN REKA BENTUK PENGIKLANAN 

 

KEPENTINGAN REKA BENTUK PENGIKLANAN 

Peniaga menggunakan iklan bagi memperkenalkan dan melariskan barangan 

dan perkhidmatan mereka kepada pengguna. 

Pelbagai cara digunakan oleh peniaga untuk mempengaruhi pengguna supaya 

membeli dan mendapatkan barangan dan perkhidmatan yang ditawarkan. 

Iklan yang menarik akan mempengaruhi pengguna untuk membeli dan 

mendapatkan perkhidmatan yang ditawarkan. 

Oleh yang demikian, pengguna harus bijak dan tidak mudah terpedaya dengan 

iklan barangan dan perkhidmatan yang terdapat pada masa ini. 

 

Kepentingan Reka 

Bentuk Pengiklanan 
Contoh Perbandingan Reka bentuk Pengiklanan 

1. Dapat 

menyampaikan 

maklumat dan 

penerangan 

dengan mudah 

dan jelas kepada 

pengguna 

  

Reka bentuk suatu iklan yang menyatakan  maklumat 

berkaitan dengan harga atau bayaran bagi sesuatu 

produk atau perkhidmatan yang ditawarkan secara 

ringkas akan lebih mudah difahami. 
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Kepentingan Reka 

Bentuk Pengiklanan 
Contoh Perbandingan Reka bentuk Pengiklanan 

2. Membolehkan 

pengguna 

membuat 

perbandingan 

tentang sesuatu 

barangan dan 

perkhidmatan. 

  

Dengan adanya maklumat yang dinyatakan dalam 

suatu iklan, pengguna akan mudah membuat 

perbandingan antara suatu produk dengan produk 

yang lain, seperti dari aspek harga, kuantiti, 

kandungan dan sebagainya. Oleh itu, reka letak yang 

tersusun dengan baik sangat penting. 

3. Memberikan 

gambaran tentang 

kualiti produk dan 

perkhidmatan. 

  

Reka bentuk, reka letak dan keseragaman tema 

warna serta imej yang digunakan dalam suatu iklan 

sering menjadi tarikan dan perhatian pengguna. 

Situasi ini menyebabkan peniaga sanggup 

melaburkan modal yang besar untuk mendapatkan  

iklan yang berkualiti. 
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Kepentingan Reka 

Bentuk Pengiklanan 
Contoh Perbandingan Reka bentuk Pengiklanan 

4. Dapat 

mempengaruhi, 

memberi daya 

tarikan dan 

mudah diingati 

oleh pengguna. 

  

Penggunaan tema yang tertentu dapat memberikan 

kesan mood yang berbeza kepada pelanggan sama 

ada untuk menyukainya ataupun tidak. Oleh itu, 

pereka grafik iklan perlu bijak mengkaji trend terkini 

yang menjadi kegemaran pengguna bagi 

memberikan imej yang positif tentang produk atau 

perkhidmatan. 

5. Dapat 

mendekatkan 

pengguna 

dengan produk 

dan perkhidmatan 

melalui 

penggunaan reka 

bentuk iklan yang 

sama dalam 

pelbagai 

media/platform 

 

Reka bentuk iklan yang fleksibel dan dapat 

digunakan secara bercetak mahupun elektronik 

menjadikannya mudah diakses dan lebih ‘dekat’ 

dengan pengguna. 
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5.2.3 PERBEZAAN KAEDAH PENGIKLANAN MENERUSI MEDIA CETAK DAN ELEKTRONIK 

 

PENGIKLANAN – MEDIA CETAK DAN MEDIA ELEKTRONIK 

1. Media pengiklanan ialah saluran, cara, atau perantaraan yang digunakan untuk 

menyampaikan iklan kepada pengguna.  

2. Setiap pengeluar atau peniaga akan menggunakan cara tersendiri dengan 

memilih kaedah pengiklanan yang sesuai untuk memasarkan produk atau 

perkhidmatan mereka.  

Media Cetak Media Elektronik 

 Bahan iklan yang disampaikan 

melalui bahan bercetak seperti 

surat khabar, majalah, katalog, 

risalah, poster, sepanduk, 

kalendar, diari dan kad 

perniagaan. 

 Beroperasi secara elektronik 

seperti radio, televisyen, 

Internet, skrin besar dan 

multimedia. 

 

 Mesej yang disampaikan lebih 

jelas dan terang serta dapat 

dibaca berkali-kali sehingga 

maksud iklan yang ingin 

disampaikan dapat difahami. 

 Mesej yang disampaikan pada 

waktu tertentu (televisyen dan 

radio) manakala laman web 

pula dapat dicapai apabila 

perlu. 

 Dicetak secara berkala dan 

memberi peluang pemasaran 

kepada pengiklan. 

 Kebanyakan rumah 

mempunyai media ini dan 

digunakan pada setiap hari. 

 Kos bandingannya dengan 

media yang lain adalah rendah 

apabila dilihat dari segi 

jangkauannya yang tinggi.  

 Kos agak tinggi dan biasanya 

mengambil masa yang agak 

lama untuk diproses. 

 Iklan perlu kreatif dan menarik 

perhatian kerana mediumnya 

terhad pada paparan 2D yang 

dicetak. 

 Iklan yang disiarkan adalah 

menarik kerana terdapat 

warna-warna yang hidup dan 

dapat ditunjukkan dengan 

jelas. 
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Media Cetak Media Elektronik 

 Merupakan media yang selektif 

dan mempunyai pembaca-

pembaca yang khusus.  Oleh 

itu, pengiklan dapat 

menghubungi sasarannya 

dengan lebih tepat. 

 Merupakan media umum dan 

dapat didengar atau ditonton 

sepanjang masa tidak kira apa-

apa yang sedang dilakukan 

oleh seseorang. 

 Iklan-iklan boleh diterbitkan 

secara sisipan dalam bentuk 

sampel, kupon dan 

sebagainya. 

 Penonton hanya dapat  melihat 

iklan dalam media dan agak 

terhad. 

 Mempunyai tempoh masa 

tertentu untuk paparan promosi 

iklan. 

 Iklan dalam media elektronik 

dapat dipaparkan berhari-hari 

dan berulang-ulang. 

 Kualiti media cetak 

mempengaruhi kualiti iklan. 

 Kualiti paparan/audio 

mempengaruhi kualiti iklan. 

 

    

Contoh pengiklanan papan iklan (billboard) cetak dan digital 

 

               

 

 

 

 

Media baharu merupakan platform 

terbaharu yang sering digunakan dalam 

pengiklanan. Imbas untuk mengetahui lebih 

lanjut mengenai pengiklanan media baharu. 
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5.2.4 MENYESUAIKAN KEPERLUAN BAHAN PROMOSI DALAM PENGIKLANAN 

 

BAHAN PROMOSI DALAM PENGIKLANAN 

Usaha mempromosikan produk kepada masyarakat umum merupakan cabaran 

yang besar. 

Promosi dapat ditakrifkan sebagai aktiviti untuk meningkatkan kesedaran 

pelanggan tentang sesuatu produk atau jenama, menjana jualan dan juga 

membina kesetiaan terhadap sesuatu jenama. 

Pengiklanan pula merupakan satu strategi promosi, kaedah komunikasi satu hala 

untuk memberitahu pelanggan maklumat tentang sesuatu produk atau 

perkhidmatan dan cara untuk mendapatkannya dalam pasaran. 

Berikut merupakan beberapa bahan promosi mengikut keperluan serta kesesuaian 

dalam pengiklanan: 

1. Gegantung (Bunting) 

 Merupakan salah satu media cetak luaran yang popular digunakan pada 

masa ini.  

 Sama seperti poster tetapi reka letaknya secara menegak iaitu tulisan ditulis 

secara menegak dari atas ke bawah dan biasanya digantung di tiang-tiang 

lampu jalan raya.  

 Sesuai dipasang ketika menyambut perayaan seperti ulang tahun bandar/ 

bandar raya, hari keputeraan atau jualan besar-besaran. 

 

 

Contoh bahan promosi gegantung (bunting) 
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2. Kain Rentang (Banner)  

 Satu media informasi dengan ukuran tertentu sama ada berbentuk potrait 

atau landscape yang berisi promosi bertujuan untuk menjual atau 

memperkenalkan sesuatu kepada khalayak. 

 Pada era digital ini, istilah kain rentang sering juga digunakan untuk 

menjelaskan media promosi yang berisi gambar dan teks dalam laman web 

atau blog yang biasanya disertai dengan link aktif yang jika diklik akan 

membawa pengguna laman web tersebut ke laman web yang 

dipromosikan. 

 

Contoh bahan promosi kain rentang  

 

3. Risalah (Leaflet/Flyers) 

 Mesej iklan peribadi yang disebarkan kepada pelanggan melalui 

perkhidmatan pos ataupun diberi secara langsung.   

 Mesej pengiklanan dalam risalah biasanya menawarkan barangan atau 

perkhidmatan yang khusus atau menawarkan koleksi barangan melalui 

katalog bagi menarik tindak balas kumpulan sasaran secara langsung.   

 Risalah juga kerap kali bersifat promosi, iaitu memberikan maklumat-

maklumat barangan dengan menawarkan ciri atau harga yang istimewa 

yang dapat diperoleh melalui pengedar-pengedar yang tertentu. 

 Selain risalah terdapat juga bahan promosi lain seperti poskad, katalog, 

brosur dan majalah syarikat. 
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Contoh bahan promosi risalah 

 

4. Poster 

 Dihasilkan secara bercetak mahupun elektronik. 

 Biasanya dalam bentuk papan iklan (billboard). Kini, kebanyakan poster 

dihasilkan dalam bentuk papar tanda. 

 Biasanya dibina pada struktur tersendiri di atas tanah, di tempat tinggi, pada 

bangunan atau hanya ditampalkan di dinding. 

 

Tahukah anda? 

Poster berbentuk digital dikenali sebagai papar tanda 

 

Contoh bahan promosi poster (billboard) 
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5. Iklan interaktif 

 Biasanya muncul dalam laman web dan media sosial.  

 Menggabungkan penggunaan elemen audio dan animasi supaya iklan 

kelihatan lebih menarik. 

 Semakin strategik lokasi iklan tersebut, semakin tertarik audiens dengan 

produk yang ditawarkan. 

 Apabila iklan tidak sesuai dengan reka letaknya, audiens tidak akan 

mempedulikan iklan tersebut. 

   

Contoh bahan promosi iklan interaktif 
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5.2.5 MENGHASILKAN REKA BENTUK BAHAN PROMOSI DENGAN 

MENGAPLIKASIKAN CIRI PENGIKLANAN YANG BAIK DENGAN 

MENGGUNAKAN PERISIAN GRAFIK 

 

CIRI-CIRI PENGIKLANAN YANG BAIK 

 

1. Jelas 

Iklan berfungsi untuk memperkenalkan sesuatu kepada masyarakat. Oleh itu, 

iklan yang dipaparkan hendaklah jelas dan mudah difahami oleh 

masyarakat agar masyarakat tertarik dengan apa-apa  yang  disampaikan. 

 

Contoh pengiklanan yang jelas 

 

CIRI-CIRI 
PENGIKLANAN 

YANG BAIK

Jelas

Media 
yang 
tepat

Kreatif

Ringkas 
dan 

padat

Ruang 
putih

Skema 
warna 

menarik

Memberi 
impak

Tipografi 
yang 

mudah

Grafik 
yang 

menarik
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2. Media yang tepat 

Pemilihan media yang digunakan seperti radio, televisyen, media cetak 

ataupun internet hendaklah tepat supaya iklan dapat disampaikan secara 

efektif. 

 

3. Kreatif 

Iklan yang disampaikan dalam apa-apa jua bentuk hendaklah kreatif dan 

unik untuk menarik minat masyarakat. 

 

Contoh bahan promosi yang kreatif 

 

4. Mesej Ringkas dan Padat 

Fokus kepada mesej utama dan objektif pengiklanan tersebut. 

 

 

Contoh iklan yang memaparkan mesej ringkas dan padat 

Jualan sempena perayaan atau peristiwa. 

Jualan untuk perkenalkan produk. 

Jualan untuk pakej baharu 
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5. Gunakan Ruang Putih (White Space) 

Iklan perlu memiliki ruang yang tenang untuk pandangan audiens. Reka 

bentuk yang padat akan menyesakkan pengiklanan dan  kelihatan tidak 

profesional.  

 

 

 

 

 

 

 

 

6. Mempunyai Skema Warna yang Menarik 

Pemilihan warna hendaklah mengikut skema warna yang sesuai. Warna latar 

belakang putih selalunya akan memudahkan teks dibaca. Sekiranya warna 

latar belakang gelap, pastikan warna tulisan kontras dengannya. 

Penggunaan warna mengikut skema warna membolehkan reka bentuk 

memiliki identiti yang konsisten. 

 

Contoh poster filem Aladdin menggunakan skema warna Triadic 

Contoh penggunaan ruang putih dalam pengiklanan 
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7. Memberikan Impak Dan Mudah Diingati 

Mempunyai reka bentuk yang membuatkan pengguna terpukau dan teruja 

dengan memasukkan unsur aneh atau jenaka bagi menarik perhatian 

pengguna untuk mengetahui lebih lanjut tentang produk yang diiklankan.  

 

Contoh bahan promosi yang menggunakan jenaka 

 

8. Gunakan Tipografi Yang Senang Dibaca 

Jenis fon, susun atur perkataan dan ayat senang dibaca.  

 

Contoh penggunaan tipografi mudah dalam pengiklanan 
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9. Imej dan Gambar Yang Menarik 

Ilustrasi mesej melalui visual sangat berkesan untuk berkomunikasi dengan 

orang ramai.  Oleh itu, gambar perlu lebih mendominasi dalam reka bentuk 

pengiklanan untuk menarik minat orang ramai mengetahui apa-apa yang 

ingin disampaikan dengan lebih lanjut. 

 

 

     Contoh reka bentuk bahan promosi yang mempunyai imej dan gambar 

yang menarik 
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LANGKAH KERJA MENGHASILKAN REKA BENTUK BAHAN PROMOSI DENGAN 

MENGAPLIKASIKAN CIRI PENGIKLANAN YANG BAIK DENGAN MENGGUNAKAN 

PERISIAN GRAFIK 

1. Melakar bahan promosi yang dipilih dengan mengaplikasikan proses 

pengolahan idea yang telah dipelajari: 

Bahan promosi: Risalah 

A. Lakaran kecil  

 

 

 

 

 

 

 

 

 

 

 

B. Lakaran kasar 
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C. Lakaran komprehensif 

 

 

2. Mengenal pasti perisian grafik yang sesuai digunakan. 

Contohnya:  
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3. Menetapkan saiz, mod dan resolusi bagi reka bentuk label pembungkusan, 

pada perisian grafik besesuaian dengan reka bentuk pembungkusan yang 

akan dihasilkan. 

 

 

4. Mengimport logo yang telah dihasilkan pada modul 5.1. 
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5. Menyisipkan imej yang bersesuaian dengan produk. 

 

 

6. Memasukkan teks yang sesuai untuk mempromosikan produk terbaharu. 
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7. Menambah elemen rekaan lain yang bersesuaian. 

 

 

8. Membuat tetapan pada imej dan teks bersesuaian dengan fungsi teks 

tersebut. 
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9. Memberikan kesan khas pada teks dan imej. 

 

 

Contoh kesan khas yang telah diaplikasikan pada karya bahan promosi. 
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10. Menyimpan hasil karya yang telah dihasilkan. 

 

 

Contoh reka bentuk bahan promosi risalah yang sudah siap dan 

mempunyai ciri iklan yang menepati kehendak pelanggan. 
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5.2.6 MENGHASILKAN BAHAN PROMOSI UNTUK TUJUAN PENGIKLANAN 

 

FORMAT FAIL BAHAN PROMOSI 

Proses akhir sebelum bahan promosi ini dicetak adalah menentukan format fail 

akhir yang akan digunakan. 

Sebagai seorang pereka grafik, kita perlulah mengenal pasti sama ada bahan 

promosi yang dihasilkan untuk dicetak atau dipaparkan secara atas talian.  

Jika bahan tersebut akan digunakan untuk kedua-dua cetakan dan paparan 

skrin, maka bahan tersebut perlu disimpan dalam beberapa format fail. 

Antara format fail yang dicadangkan adalah: 

1. Format fail yang biasa digunakan untuk tujuan cetakan seperti: 

a) TIFF (Tagged-Image file Format)  

 Fail TIFF boleh dibuka oleh hampir kesemua perisian penyuntingan imej. 

 TIFF paling sesuai untuk menyimpan fail imej bagi kegunaan high-end 

yang memerlukan informasi penuh imej tersebut. 

 TIFF sesuai untuk cetakan kerana proses cetakan memerlukan 

kandungan piksel yang tinggi dan padat. 
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b) EPS (Encapsulated PostScript) 

 EPS ialah format fail yang disokong oleh kebanyakan perisian 

penyuntingan grafik.  

 EPS boleh mengandungi teks, gambar dan grafik.  

 

 

c) PDF (Portable Document File) 

 PDF menyimpan maklumat fail sumber seperti teks, gambar, video, 

grafik warna penuh dan foto.  

 PDF boleh dibuka dalam perisian Adobe Acrobat, Photoshop dan 

Illustrator, Microsoft Word, InDesign dan Quark Xpress.  

 PDF dapat dipindahkan ke seluruh platform.  

 PDF dapat mengekalkan kualiti imej vektor, imej bitmap, fon dan 

gambar yang terdapat di dalamnya. 
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2. Format fail yang digunakan untuk menyimpan fail yang digunakan secara 

atas talian seperti: 

a) JPEG (Joint Photographic Experts Group) 

 JPEG merupakan format fail yang sangat “mesra foto”. 

 JPEG memampatkan data/imej fail yang disimpan dan juga 

membuang data atau imej tambahan di luar apa yang dapat dilihat 

oleh mata manusia.  

 JPEG disebut sebagai format "lossy" yang bermaksud bahawa setiap 

kali karya disimpan dan dimampatkan semula, ia akan kehilangan 

kualiti.  

 JPEG sesuai untuk grafik pegun, fotografi, imej dengan warna yang 

kompleks dan dinamik. 
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b) GIF (Graphics Interchange Format) 

 GIF berfungsi untuk memuat naik fail bersaiz kecil untuk dilihat secara 

atas talian.  

 Fail GIF mempunyai antara 2 hingga 256 warna. 

 Semakin banyak warna dalam dokumen, semakin besar saiz fail.  

 Fail GIF baik untuk grafik tetap (flat graphics). 

 GIF sesuai untuk animasi, namun masih boleh menghasilkan imej 8-bit 

yang kecil.  

 GIF sangat sesuai untuk menyimpan fail dengan penggunaan warna 

yang sedikit.  
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c) PNG (Portable Network Graphics) 

 PNG adalah gabungan antara GIF dan JPEG. 

 PNG adalah pilihan yang baik untuk transparensi dan tiada 

kemerosotan kualiti. 

 Format fail PNG bersaiz lebih kecil berbanding GIF dan JPEG.  
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AKTIVITI  

 

BAHAN DAN PERALATAN  

1. Perisian Microsoft Power Point 

2. Internet 

 

TUGASAN 1 

 

Hasilkan peta pemikiran tentang definisi, kepentingan reka bentuk 

dan media yang dapat digunakan untuk pengiklanan.  

 

 

LANGKAH KERJA (TUGASAN 1) 

 

1. Murid meneroka peta pemikiran tentang definisi, kepentingan reka bentuk 

dan media yang dapat digunakan untuk pengiklanan. 

2. Murid menghasilkan slaid persembahan menggunakan Microsoft Power Point 

secara berkumpulan. 

3. Murid membuat pembentangan secara berkumpulan. 

 

 

 

Anda kreatif? 

Buat kajian lapangan untuk menghasilkan bahan promosi yang 

menarik. 
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BAHAN DAN PERALATAN  

1. Kertas A4 

2. Alat tulis 

3. Perisian grafik yang bersesuaian 

4. Komputer 

 

 

TUGASAN 2 

 

Buat kajian lapangan tentang reka bentuk bahan promosi 

berdasarkan tema dan buat lakaran idea. Hasilkan bahan 

promosi dalam bidang pengiklanan berdasarkan tema. 

 

LANGKAH KERJA (TUGASAN 2) 

1. Murid membuat kajian lapangan mengenai reka bentuk bahan promosi 

berdasarkan tema yang diberikan. 

 

2. Murid membuat lakaran idea (lakaran kecill, lakaran kasar dan lakaran 

komprehensif). 

 

3. Murid menghasilkan bahan promosi menggunakan perisian grafik yang 

bersesuaian. 

 

Anda kreatif? 

Buat kajian lapangan untuk menghasilkan bahan promosi yang 

bertemakan iklan komersial dan sesuai dengan media yang 

dipilih. 
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LATIHAN / PENILAIAN 

Jawab semua soalan. 

1. Apakah langkah pertama proses membuat bahan promosi? 

a. Menentukan jenis bahan yang akan digunakan 

b. Menentukan bentuk persembahan bahan promosi 

c. Membuat beberapa lakaran untuk bahan promosi 

d. Menentukan tema dan tajuk 

 

2. Apakah jenis reka grafik di bawah ? 

 

a. Reka bentuk korporat 

b. Reka bentuk poster 

c. Pembungkusan 

d. Risalah 

 

3. Apakah cara promosi yang paling sesuai untuk mengiklankan perkhidmatan 

menggunting rambut di kawasan perumahan? 

a. Risalah 

b. Iklan televisyen 

c. Iklan surat khabar 

d. Iklan dalam majalah 

4. Berikut merupakan jenis bahan promosi KECUALI: 
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a. Kain rentang 

b. Gegantung 

c. Poster 

d. Majalah 

 

5. Berikut merupakan ciri-ciri iklan yang baik KECUALI: 

a. Jelas 

b. Memasukkan semua maklumat 

c. Menggunakan tipografi yang bersesuaian 

d. Menggunakan skema warna yang menarik 

 

6. Nyatakan maksud pengiklanan. 

……………………………………………………………………………………………. 

……………………………………………………………………………………………. 

……………………………………………………………………………………………. 

 

7. Senaraikan 2 perbezaan media pengiklanan di bawah. 

 

Media Cetak Media Elektronik 

 

 

 

 

 

  

 

 

 



54 
 

8. Nyatakan 3 ciri pengiklanan yang baik. 

i. …………………………………………….. 

ii. …………………………………………….. 

iii. …………………………………………….. 

 

9. Nyatakan 5 langkah untuk menghasilkan bahan promosi bagi tujuan 

pengiklanan. 

i. …………………………………………….. 

ii. …………………………………………….. 

iii. …………………………………………….. 

iv. …………………………………………….. 

v. …………………………………………….. 

 

10.  Senaraikan 5 jenis bahan promosi. 

i. …………………………………………….. 

ii. …………………………………………….. 

iii. …………………………………………….. 

iv. …………………………………………….. 

v. …………………………………………….. 
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LAPORAN PENCAPAIAN MURID 

 

Nama Murid  

 

Tahun  

 

Kelas  

 

 

Standard 

Kandungan 

5.2 Pengiklanan 

Standard 

Pembelajaran 

5.2.1 Menyatakan maksud pengiklanan 

 

5.2.2 Menjelaskan kepentingan reka bentuk pengiklanan 

 

 

5.2.3 Membanding beza kaedah pengiklanan menerusi 

media: 

i. Cetak 

ii. Elektronik 

 

5.2.4 Menyesuaikan keperluan bahan promosi dalam 

pengiklanan seperti: 

i. Gegantung  

ii. Kain rentang  

iii. Risalah  

iv. Poster  

v. Iklan interaktif  

 

5.2.5 Menghasilkan reka bentuk bahan promosi dengan 

mengaplikasikan ciri pengiklanan yang baik dengan 

menggunakan perisian grafik.  

 

5.2.6 Menghasilkan bahan promosi untuk tujuan 

pengiklanan. 
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Bil Perkara yang dinilai Pencapaian Catatan 

Terampil 
Belum 

Terampil 

1 Menyatakan maksud pengiklanan    

2 
Menyenaraikan kepentingan reka 

bentuk pengiklanan. 
  

 

3 

Menyatakan perbezaan kaedah 

pengiklanan menerusi media cetak 

dan elektronik. 

  

 

4 

Menyatakan keperluan bahan 

promosi dalam pengiklanan seperti 

gegantung, kain rentang, risalah, 

poster dan iklan interaktif. 

  

 

5 

Menghasilkan reka bentuk bahan 

promosi dengan mengaplikasikan 

ciri pengiklanan yang baik dengan 

menggunakan perisian grafik.  

  

 

6 
Menghasilkan bahan promosi untuk 

tujuan pengiklanan. 
  

 

KEPUTUSAN 
(CAPAI / TIDAK CAPAI) 

TARIKH 

 

 

 

Nama Guru  Tandatangan & 

Tarikh 

 

Disahkan oleh  Tandatangan & 

Tarikh 
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KEPUTUSAN STANDARD PRESTASI 
 

 

 

Nama Murid  

Tahun:  

Kelas  

 

Modul 5.0 Penghasilan Karya Grafik Digital 

Standard 

Kandungan 

5.2 Pengiklanan 

 

 
Standard Prestasi Terampil 

Tahap 

Penguasaan 
Tafsiran Ya Belum 

1 
Menyatakan maksud dan kepentingan 

pengiklanan. 

  

2 

Menjelaskan kaedah pengiklanan menerusi media 

cetak dan elektronik berserta contoh bahan 

promosi yang sesuai. 

  

3 

Menghasilkan reka bentuk bahan promosi 

berdasarkan tema dengan melalui proses 

pengolahan idea. 

  

4 
Membuat analisis kesesuaian reka bentuk bahan 

promosi yang baik dalam pengiklanan. 

  

5 

Menilai dan memberi justifikasi reka bentuk bahan 

promosi berdasarkan elemen dan prinsip rekaan 

grafik secara rasional. 

  

6 

Menghasilkan bahan promosi dengan menekankan 

aspek kandungan dan nilai estetika secara beretika, 

sistematik, bermakna dan kreatif. 

  

 

Keputusan Tahap  

 

Nama Guru  Tandatangan & 

Tarikh 

 

Disahkan 

oleh 

 Tandatangan & 

Tarikh 
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MODUL 5.3 

Standard 

kandungan 

: 5.3 Pembungkusan 

Standard 

pembelajaran 

: 5.3.1 Menyatakan maksud pembungkusan. 

5.3.2 Menjelaskan kepentingan reka bentuk pembungkusan. 

5.3.3 Mengenal pasti maklumat label reka bentuk 

pembungkusan. 

5.3.4 Menyesuaikan bahan pembungkusan berdasarkan jenis 

barangan. 

5.3.5 Melakar reka bentuk label pembungkusan. 

5.3.6 Menentukan ciri reka bentuk label pembungkusan yang 

baik. 

5.3.7 Menghasilkan reka bentuk label pembungkusan yang 

baik dengan menggunakan perisian grafik. 

5.3.8 Menyediakan label pada pembungkusan. 

Objektif 

pembelajaran 

: ▪ Menyatakan maksud pembungkusan 

▪ Menyenaraikan kepentingan reka bentuk pembungkusan 

▪ Menyenaraikan maklumat label reka bentuk 

pembungkusan 

▪ Menyatakan  bahan pembungkusan yang sesuai 

berdasarkan jenis bahan 

▪ Menyenaraikan ciri-ciri reka bentuk label pembungkusan 

yang baik 

▪ Membuat lakaran reka bentuk label pembungkusan 

▪ Menghasilkan reka bentuk label pembungkusan  

▪ Mencetak reka bentuk label pembungkusan  

Masa : 40 jam 
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NOTA RUJUKAN 

5.3.1 MAKSUD PEMBUNGKUSAN 

 

PENGENALAN 

Pembungkusan merupakan satu elemen penting bagi menjamin keselamatan 

suatu produk yang dipasarkan.  

Kaedah pembungkusan produk merupakan salah satu elemen yang perlu 

dititikberatkan dalam merancang pengeluaran sesuatu produk.  

Kaedah pembungkusan juga menggambarkan kualiti produk dan identiti 

syarikat yang mengeluarkan produk tersebut.  

Pembungkusan produk yang terbaik merupakan pembungkusan yang 

memenuhi kehendak pengguna dan dapat menarik pengguna untuk membeli 

produk yang dipasarkan. 

 

MAKSUD PEMBUNGKUSAN 

Pembungkusan merupakan satu bekas yang memegang, menyimpan, 

melindungi sesuatu barangan daripada rosak atau tercemar, dan membolehkan 

produk dikenal pasti. 

 

Jenis-jenis pembungkusan 

Pembungkusan dibahagikan kepada pembungkusan konvensional dan 

pembungkusan moden. Setiap jenis pembungkusan ini menggunakan bahan 

yang berbeza-beza. 

 

 

 

 

 



60 
 

Pembungkusan Konvensional Pembungkusan Moden 

Penggunaan bahan berasaskan 

tumbuhan 

Penggunaan kertas dan kadbod 

Penggunaan bahan berasaskan 

haiwan (kulit haiwan) 

Penggunaan bahan logam 

Penggunaan bekas berasaskan tanah 

liat 

Penggunaan bahan kaca 

Kertas surat khabar dan daun pisang Penggunaan bahan plastik 

Kertas surat khabar sahaja Penggunaan bahan polistirena 

 

Contoh pembungkusan konvensional 

 

 

 

Nasi lemak  Ketupat palas 

   

 

 

 

Alat tulis  Air minuman 
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Contoh pembungkusan moden 

 

 

 

Bahan pencuci  Makanan  

   

 

 

 

Buah-buahan  Air minuman 
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5.3.2 MENJELASKAN KEPENTINGAN REKA BENTUK PEMBUNGKUSAN 

  

REKA BENTUK PEMBUNGKUSAN 

Reka bentuk pembungkusan merupakan proses menghasilkan pelbagai bentuk 

dan saiz pembungkusan produk perdagangan seperti pembungkusan produk 

makanan dan bukan makanan (produk penjagaan diri, barang elektrik, 

elektronik dan sebagainya). 

 

KEPENTINGAN REKA BENTUK PEMBUNGKUSAN 

 

 

 

 

 

  
Kepentingan 
Reka Bentuk 

Pembungkusan 

  

 

Memelihara 
mutu dan 

fizikal 
produk 

 
Menyampaikan 

maklumat 
produk 

 
Mengawal 

keselamatan 
produk   

 Meningkatkan 
jualan 

 
Menarik 

perhatian 
pengguna 

 

Menepati 
keperluan 

dan 
peraturan 



63 
 

Memelihara mutu dan fizikal produk 

 Produk boleh bertahan lebih lama dan dalam keadaan yang baik. 

 Mengekalkan mutu dan fizikal produk. 

                   

 

A. Menyampaikan maklumat produk 

 Maklumat yang lengkap membantu pengguna mengetahui perkara 

yang berkaitan dengan produk seperti nama pengeluar, jenama, ilustrasi 

atau gambar foto yang berkaitan dengan produk,  berat bersih, isi 

kandungan bahan dan tarikh luput. 

 

 

B. Mengawal keselamatan produk 

 Mengawal keselamatan produk daripada kerosakan atau kebocoran. 
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C. Meningkatkan jualan 

 Reka bentuk pembungkusan yang menarik secara tidak langsung akan 

meningkatkan jualan sesuatu produk. 

 

D. Menarik perhatian pengguna 

 Reka bentuk pembungkusan merupakan salah satu cabang 

pengiklanan.  

 Rekaan yang menarik dan kreatif akan menarik perhatian pengguna. 

 

E. Menepati keperluan dan peraturan 

 Reka bentuk sesuatu pembungkusan mestilah menepati keperluan jenis 

bahan produk. 

 Setiap produk terutamanya produk makanan perlu dikotakkan, 

dibungkus, ditutup atau sebagainya untuk melindungi produk tersebut 

daripada rosak atau kotor. Peraturan ini termaktub dalam Akta Makanan 

1983. 

 

 

 

 

 

 

 

  



65 
 

5.3.3 MENGENAL PASTI MAKLUMAT LABEL REKA BENTUK PEMBUNGKUSAN 

 

LABEL PEMBUNGKUSAN 

Label merupakan reka bentuk grafik pada sesuatu permukaan seperti kertas, 

kad atau bahan yang lain untuk memberi penerangan terperinci mengenai 

pengeluar, nama produk, cara penggunaan, perihal produk dan sebagainya.  

 

Susunan reka letak label bergantung kepada:  

a) JENAMA  -  tanda atau simbol perniagaan, logo  

b) IMEJ   -  reka bentuk produk, illustrasi  

c) SASARAN  -  golongan dewasa atau kanak-kanak  

 

Contoh Jenama Contoh Imej 

 

 

 

 

 

 

Contoh Sasaran 
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Maklumat label reka bentuk pembungkusan bergantung pada jenis produk atau 

barangan yang dikeluarkan.  

Antara maklumat yang dinyatakan pada pembungkusan ialah: 

A. Produk Makanan: 

i. Nama pengeluar atau syarikat 

ii. Nama produk/ jenama barangan 

iii. Isi kandungan bahan 

iv. Berat bersih 

v. Tarikh pengeluaran dan tarikh luput 

vi. Ilustrasi atau gambar foto yang berkaitan dengan barangan 

vii. Aspek-aspek lain yang berkaitan 

 

 

 

 

 

 

 

 

 

 

 

 

 

Contoh label pada pembungkusan produk makanan 

 

Best before: 

 
Nama produk/ 

jenama barangan 

  Isi kandungan 

bahan 

 
Ilustrasi atau 

gambar foto yang 

berkaitan dengan 

barangan 

 

Berat bersih 

 

Nama pengeluar 

atau syarikat 

 

Tarikh luput 

 
Aspek -aspek lain: 

Barcode 
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B. Produk Bukan Makanan: 

i. Senarai bahan 

ii. Berat bersih kandungan 

iii. Jenama dan ilustrasi (jika perlu) 

iv. Amaran jika bahan mengandungi racun 

v. Logo, nama syarikat dan alamat pembuat barangan 

vi. Keterangan tentang cara penggunaan dan pemeliharaannya 

viii. Tarikh pengeluaran dan tarikh luput (jika mengandungi bahan kimia) 

 

 

 

 

 

 

 

  

 

 

 

Contoh pembungkusan hasil bukan makanan 
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5.3.4 MENYESUAIKAN BAHAN PEMBUNGKUSAN BERDASARKAN JENIS BARANGAN 

 

BAHAN PEMBUNGKUSAN BERDASARKAN JENIS BARANGAN 

Jenis Barangan Bahan Pembungkusan 

Barangan lembut atau 

serbuk 

Contoh: pakaian, 

kosmetik, talkum, susu, 

serbuk pencuci, 

tepung, bijirin dan 

lain-lain. 

 

i. Logam (Aluminium dan tin) 

ii. Plastik 

       

Barangan keras 

Contoh: peralatan 

elektrik, alat 

pertukangan, mesin 

dan lain-lain 

 

 

 

i. Kertas dan kadbod 

ii. Polistirena 

iii. Logam (Aluminium dan tin) 

                 

Barangan cecair dan 

krim 

Contoh: minuman, 

minyak, cecair 

pencuci dan ubat-

ubatan. 

 

 

 

i. Kaca    

ii. Plastik (tiub) 

iii. Logam (Aluminium dan tin) 

iv. Kertas dan Kadbod 
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5.3.5 MELAKAR REKA BENTUK LABEL PEMBUNGKUSAN 

 

LAKARAN REKA BENTUK LABEL PEMBUNGKUSAN 

Lakaran reka bentuk memainkan peranan penting dalam menentukan konsep 

awal proses penghasilkan reka bentuk sesuatu produk. 

Lakaran reka bentuk ialah satu lukisan awal atau lukisan draf sesuatu reka bentuk 

yang dihasilkan menggunakan teknik lakaran bebas yang terdiri daripada: 

a) Lakaran kecil 

b) Lakaran kasar 

c) Lakaran komprehensif 

Sebelum lakaran label pembungkusan dihasilkan, reka bentuk pembungkusan 

perlu dikenal pasti terlebih dahulu. 

 

Proses ini melibatan proses pengolahan idea iaitu: 

A. LAKARAN KECIL 

Lakaran kecil mengandungi sekurang-kurangnya enam(6) lakaran kecil. 

 

Contoh lakaran kecil reka bentuk pembungkusan 
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Contoh lakaran kecil reka bentuk label pembungkusan 

 

B. LAKARAN KASAR 

Lakaran kasar mengandungi sekurang-kurangnya satu(1) lakaran kasar yang 

dipilih berdasarkan lakaran kecil. 

 

Reka bentuk pembungkusan yang dipilih 
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Contoh lakaran kasar reka bentuk label pembungkusan berdasarkan reka 

bentuk pembungkusan yang dipilih 

 

C. LAKARAN KOMPREHENSIF 

Lakaran komprehensif ialah lakaran kasar yang telah diperhalusi dan 

ditambahbaik. 

 

Contoh lakaran komprehensif reka bentuk label pembungkusan 
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5.3.6 MENENTUKAN CIRI REKA BENTUK LABEL PEMBUNGKUSAN YANG BAIK 

 

REKA BENTUK LABEL PEMBUNGKUSAN 

Sesuatu reka bentuk label pembungkusan yang baik bergantung kepada 

beberapa ciri. Ciri-ciri ini juga ada kaitannya dengan ciri-ciri pembungkusan itu 

sendiri. 

Ciri-ciri pembungkusan yang baik adalah seperti berikut: 

a) Mudah dibuka 

b) Mudah ditutup 

c) Mudah disimpan 

d) Mudah diperiksa 

e) Mudah dipegang 

f) Boleh diguna semula 

g) Dapat dikitar semula 

h) Mudah dibuang/ dilupuskan 

 

Seorang pemilik produk pasti inginkan produknya dikenali ramai dan kelihatan 

setaraf produk ternama. Produk tersebut biasanya akan dikenali melalui label 

pembungkusannya.  
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Ciri-ciri reka bentuk label pembungkusan yang baik ialah: 

a) Nama produk pada label produk 

Nama produk ialah salah satu aspek penting yang perlu ada pada sesuatu 

produk bagi memudahkan pengguna mengetahui barangan yang 

terdapat dalam pasaran.  

 

 

b) Tanda harga pada barangan 

Tanda harga yang diletakkan haruslah jelas dan betul. Hal ini penting agar 

pengguna tidak berasa tertipu apabila mereka membeli sesuatu 

barangan.  

 

 

c) Tarikh luput pada barangan yang dijual 

Pengguna dapat membezakan produk yang sudah tidak boleh digunakan 

dengan produk yang masih boleh digunakan.  
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d) Bahan yang digunakan untuk membuat sesuatu barangan 

Pengguna dapat mengetahui ramuan atau bahan yang digunakan untuk 

membuat produk tersebut. Dengan itu, pengguna dapat meneliti produk 

yang akan dibeli terlebih dahulu dan dapat memastikan bahan yang 

digunakan. 

 

 

e) Kelulusan barangan tersebut 

Sebagai contoh, logo halal merupakan satu aspek terpenting yang perlu 

ada pada label sesuatu produk. Hal ini dapat membantu umat Islam 

memilih makanan untuk dijadikan santapan harian mereka tanpa 

keraguan.  

   

 

f) Fakta nutrisi 

Biasa terdapat pada label pembungkusan makan. Bahan makanan 

seharusnya dipaparkan bagi memudahkan pengguna untuk mengetahui 

nilai nutrisi yang terdapat dalam makanan tersebut.  
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g) Tanda amaran 

Tanda amaran berfungsi untuk menegaskan bahawa setiap barang itu 

boleh digunakan pada tahap tertentu sahaja. Sebagai contoh, tanda 

amaran pada label produk racun pembunuh serangga amat penting 

kerana produk ini mengandungi bahan-bahan yang beracun dan 

berbahaya.  

 

 

h) Nombor telefon, faks, alamat dan laman web pengeluar yang dapat 

dihubungi 

Bagi membolehkan pengguna produk mereka memberikan maklum 

balas mengenai produk mereka. Maklum balas yang diberikan oleh 

pengguna tidak semestinya aduan mengenai produk tetapi kadangkala 

cadangan yang dapat membantu syarikat pengeluar produk untuk 

menambah baik produk dan mengembangkan pasaran produk mereka 

lagi. 
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5.3.7 MENGHASILKAN REKA BENTUK LABEL PEMBUNGKUSAN YANG BAIK DENGAN 

MENGGUNAKAN PERISIAN GRAFIK 

 

Reka bentuk label pembungkusan dapat dihasilkan menggunakan beberapa 

perisian grafik. Contohnya: 

a) Adobe Photoshop 

b) Adobe Illustrator 

c) Adobe Indesign 

d) Macromedia Freehand 

e) Scribus 

f) Krita 

 

PROSES PENGHASILAN REKA BENTUK LABEL PEMBUNGKUSAN MENGGUNAKAN 

PERISIAN GRAFIK 

1. Mengenal pasti perisian grafik yang sesuai digunakan. 

  Contohnya:  
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2. Menetapkan saiz, mod dan resolusi bagi reka bentuk label pembungkusan, 

pada perisian grafik besesuaian dengan reka bentuk pembungkusan yang 

akan dihasilkan. 

 

 

3. Mengimport logo yang telah dihasilkan pada modul 5.1. 
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4. Menyisipkan imej yang bersesuaian dengan produk. 

 

 

5. Memasukkan teks yang sesuai untuk nama produk, maklumat produk, 

maklumat penjual dan maklumat-maklumat lain yang perlu. 
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6. Membuat tetapan pada imej dan teks bersesuaian dengan fungsi teks 

tersebut. 

 

 

7. Memberikan kesan khas yang bersesuaian pada teks dan imej. 
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8. Menyimpan hasil karya dalam format fail yang bersesuaian. 

 

 

 

Hasil akhir label pembungkusan 
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5.3.8 MENYEDIAKAN LABEL PADA PEMBUNGKUSAN 

 

PROSES MENYEDIAKAN LABEL PADA PEMBUNGKUSAN 

Dalam fasa ini, hasil karya akan dicetak mengikut spesifikasi yang ditetapkan 

berdasarkan reka bentuk pembungkusan. Spesifikasi ini akan dijadikan sebagai 

mekap contoh. 

Contoh spesifikasi cetakan ialah: 

a) Jenis cetakan 

      

Cetakan hitam/putih    Cetakan skala kelabu 

 

 

Cetakan berwarna 
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b) Saiz cetakan 

 

 

Cetakan saiz 100% 

 

           

              Cetakan saiz 50%                                    Cetakan saiz 10% 
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Contoh label pembungkusan pada bungkusan  

 

 

  



84 
 

AKTIVITI  

 

BAHAN DAN PERALATAN  

1. Perisian grafik 

2. Kertas lukisan 

3. Pencetak 

 

 

TUGASAN  

Murid menghasilkan label pembungkusan berdasarkan tema 

yang telah ditetapkan oleh guru dengan menggunakan perisian 

penyuntingan grafik yang bersesuaian. 

 

 

LANGKAH KERJA (TUGASAN 1) 

1. Murid melaksanakan kajian lapangan berkaitan label pembungkusan dengan 

tema yang telah ditetapkan. 

2. Murid membuat lakaran kecil, lakaran kasar dan lakaran komprehensif label 

pembungkusan yang akan dihasilkan. 

3. Murid menghasilkan label pembungkusan berdasarkan lakaran komprehensif 

yang telah dihasilkan dengan menggunakan perisian penyuntingan grafik yang 

bersesuaian. 

4. Murid mencetak hasil karya. 

 

Anda kreatif? 

Buat proses pengolahan idea untuk menghasilkan label 

pembungkusan bagi produk bukan makanan. 
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LATIHAN / PENILAIAN 

Jawab semua soalan. 

1. Nyatakan maksud pembungkusan. 

 

…………………………………………………………………………………………. 

…………………………………………………………………………………………. 

…………………………………………………………………………………………. 

 

 

2. Senaraikan jenis-jenis bahan pembungkusan. 

 

i. …………………………………………….. 

ii. …………………………………………….. 

iii. …………………………………………….. 

iv. …………………………………………….. 

 

 

3. Nyatakan 4 jenis pembungkusan. 

 

i. …………………………………………….. 

ii. …………………………………………….. 

iii. …………………………………………….. 

iv. …………………………………………….. 
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4. Berikan 5 kepentingan reka bentuk pembungkusan. 

 

i. …………………………………………….. 

ii. …………………………………………….. 

iii. …………………………………………….. 

iv. …………………………………………….. 

v. …………………………………………….. 
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LAPORAN PENCAPAIAN MURID 

Nama Murid  

Tahun  

Kelas  
 

Standard 

Kandungan 

5.3 Pembungkusan 

 

Standard 

Pembelajaran 

5.3.1 Menyatakan maksud pembungkusan. 

5.3.2 Menjelaskan kepentingan reka bentuk pembungkusan. 

5.3.3 Mengenal pasti maklumat label reka bentuk 

pembungkusan. 

5.3.4 Menyesuaikan bahan pembungkusan berdasarkan jenis 

barangan. 

5.3.5 Melakar reka bentuk label pembungkusan. 

5.3.6 Menentukan ciri reka bentuk label pembungkusan yang 

baik. 

5.3.7 Menghasilkan reka bentuk label pembungkusan yang 

baik dengan menggunakan perisian grafik. 

5.3.8 Menyediakan label pada pembungkusan. 

 

Bil Perkara yang dinilai 

Pencapaian 

Catatan 
Terampil 

Belum 

Terampil 

1 Menyatakan maksud pembungkusan    

2 
Menyenaraikan kepentingan reka 

bentuk pembungkusan 
  

 

3 
Menyenaraikan maklumat label reka 

bentuk pembungkusan 
  

 

4 
Menyatakan  bahan pembungkusan 

yang sesuai berdasarkan jenis bahan 
  

 

5 
Menyenaraikan ciri-ciri reka bentuk label 

pembungkusan yang baik 
  

 

6 
Membuat lakaran reka bentuk label 

pembungkusan 
  

 

7 
Menghasilkan reka bentuk label 

pembungkusan  
  

 

8 
Mencetak reka bentuk label 

pembungkusan  
  

 

KEPUTUSAN 
(CAPAI / TIDAK CAPAI) 

TARIKH 
 

 

Nama Guru  Tandatangan & Tarikh  

Disahkan oleh  Tandatangan & Tarikh  
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KEPUTUSAN STANDARD 

Nama Murid  

Tahun  

Kelas  

 

Modul 5.0 PENGHASILAN KARYA GRAFIK DIGITAL 

Standard 

Kandungan 
5.3  Pembungkusan 

 

Standard Prestasi Terampil 

Tahap 

Penguasaan 
Tafsiran Ya Belum 

1 
Menyatakan maksud dan kepentingan 

reka bentuk pembungkusan. 

  

2 

Memberi contoh reka bentuk 

pembungkusan berdasarkan bahan dan 

jenis barangan. 

  

3 

Menghasilkan reka bentuk label 

pembungkusan berdasarkan bahan dan 

jenis barangan dengan melalui proses 

pengolahan idea. 

  

4 

Membuat analisis hasil reka bentuk label 

pembungkusan berdasarkan ciri reka 

bentuk pembungkusan yang baik. 

  

5 

Menilai dan memberi justifikasi reka 

bentuk label pembungkusan 

berdasarkan elemen dan prinsip rekaan 

grafik secara rasional. 

  

6 

Menghasilkan rekaan pembungkusan 

dengan menekankan aspek kandungan 

dan nilai estetika secara beretika, 

sistematik, bermakna dan kreatif. 

  

 

Keputusan Tahap  

 

Nama Guru  
Tandatangan & 

Tarikh 

 

Disahkan 

oleh 
 

Tandatangan & 

Tarikh 
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KEMENTERIAN PENDIDIKAN MALAYSIA 

Kurikulum Standard Sekolah Menengah (KSSM) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Mata Pelajaran Vokasional (MPV) 

REKA BENTUK GRAFIK DIGITAL 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

MODUL 6: REKA BENTUK PENERBITAN MEJA 

(DESKTOP PUBLISHING) 

 

 

 

 

 

MODUL 6.1 
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Standard 

kandungan 

: 6.1 Asas Penerbitan Meja  

Standard 

pembelajaran 

: 6.1.1 Mengenal pasti definisi penerbitan meja.  

6.1.2 Memberi contoh karya penerbitan meja.  

6.1.3 Menerangkan keperluan perkakasan dan perisian 

penerbitan meja.  

6.1.4 Membanding beza penerbitan meja:  

         (i) Media cetak  

         (ii) Media elektronik 

Objektif 

pembelajaran 

:  Mentakrif definisi penerbitan meja 

 Menyenaraikan contoh karya penerbitan meja 

 Menyatakan keperluan perkakasan dan perisian 

penerbitan meja 

 Menyatakan perbezaan penerbitan meja menerusi 

media cetak dan elektronik 

Masa : 10 jam 
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NOTA RUJUKAN 

6.1 ASAS PENERBITAN MEJA 

6.1.1 MENGENAL PASTI DEFINISI PENERBITAN MEJA 

 

PENGENALAN 

Penerbitan meja dicipta pada tahun 1978, apabila perisian TeX membuktikan 

bahawa typesetting berkualiti percetakan boleh dilakukan dengan 

menggunakan sebarang komputer perdagangan biasa.  

 

Tugas yang banyak dan rumit seperti buku dan jurnal boleh dihasilkan dengan 

menggunakan terminal atas meja piawaian. 

 

Pada tahun 1985, penerbitan meja tersedia untuk masyarakat umum, bersama 

dengan Aldus Pagemaker (yang kemudiannya diambil alih oleh Adobe). 

 

Perubahan teknologi yang pantas menyebabkan penghasilan reka bentuk dan 

reka letak halaman turut mengalami perubahan. Sejak abad ke-15 sehingga abad 

ke-20 proses reka bentuk dan reka letak halaman dilakukan sepenuhnya oleh 

manusia.  

 

 

MAKSUD PENERBITAN MEJA 

 

Penerbitan meja adalah proses menyunting dan mereka letak bahan bercetak 

untuk tujuan penerbitan, seperti buku, majalah, brosur, risalah, dan seumpamanya 

dengan menggunakan komputer peribadi.  

 

Penerbitan meja juga merupakan proses penghasilan barangan untuk cetakan 

secara elektronik. 

 

Proses ini membolehkan pengguna melakukan penerbitan mereka sendiri 

menggunakan komputer dengan perisian yang sesuai. 
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6.1.2 CONTOH KARYA PENERBITAN MEJA 

 

KARYA PENERBITAN MEJA 

Terdapat pelbagai jenis karya penerbitan meja yang sering digunakan dalam 

kehidupan seharian contohnya kad nama, menu dan brosur.  Karya penerbitan 

yang lebih kompleks adalah seperti buku, majalah, katalog dan daftar harga.  

 

CONTOH KARYA PENERBITAN MEJA 

 

 

 

Buku  Majalah 

   

 

 

 

Risalah  Flyer 

   

 

 

 

Katalog  Kalendar 
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Kad Nama  Kepala Surat 

 

        

       

 
 

 

  

 

     

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Imbas kod QR 
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6.1.3 MENERANGKAN KEPERLUAN PERKAKASAN DAN PERISIAN PENERBITAN MEJA 

 

PERKAKASAN DAN PERISIAN PENERBITAN MEJA PENGENALAN 

 

Teknologi penerbitan meja adalah teknologi yang terdiri daripada gabungan 

beberapa perkakasan dan juga beberapa perisian.  

Perisian ini tidak menggantikan pemproses kata dan aplikasi grafik, tetapi 

digunakan untuk menggabungkan kandungan yang dicipta dengan lebih mudah. 

Antaranya perkakasan dan perisian ini ialah: 

(a) Perkakasan  

 

 

 

 

 

 

 

 

Komputer  Pencetak  Pengimbas  
Kamera 

Digital 

 

 

(b) Perisian 

(i) Perisian Pemprosesan Perkataan 

 Perisian ini merupakan perisian komputer yang digunakan untuk 

mengarang, memformat, menyunting, dan mencetak dokumen.  

 Pemproses perkataan merupakan perisian penggunaan terawal yang 

digunakan untuk meningkatkan lagi produktiviti pejabat dan komputer 

peribadi. 

 Perisian ini membolehkan penggunanya memilih antara penaipan 

biasa dan penukaran mod-mod pemprosesan perkataan.  

 

 Contoh perisian pemprosesan perkataan berlesen: 

o WordStar 

o WordPerfect 

o Microsoft Word 

https://ms.wikipedia.org/wiki/Perisian
https://ms.wikipedia.org/wiki/Komputer
https://ms.wikipedia.org/wiki/Komputer_peribadi
https://ms.wikipedia.org/wiki/Komputer_peribadi
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WordStar  WordPerfect  Microsoft Word 

 

 Microsoft Word merupakan sistem pemprosesan perkataan komputer 

yang paling meluas digunakan pada masa kini.  

 Contoh perisian pemprosesan perkataan sumber terbuka: 

o Google Docs 

– digunakan untuk memproses perkataan secara dalam talian. 

 

 

(ii) Perisian Penyuntingan Imej 

 Perisian ini boleh menghasilkan data media dalam bentuk grafik iaitu 

sebarang data media sama ada dalam bentuk teks atau imej.  

 Perisian ini boleh memperbaiki atau merubah rupa grafik mengikut 

kesesuaian warna dan saiznya. 

 Antara format fail piawai bagi perisian grafik adalah JPEG, PICT, BMP 

dan TIFF. 

 Contoh perisian penyuntingan imej berlesen: 

o Adobe Photoshop 

o Microsoft Paint 

o Ulead Photoimpact 
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Adobe 

Photoshop 
 Microsoft Paint  

Ulead Photo 

Impact 

 

 Contoh perisian penyuntingan imej sumber terbuka: 

o GIMP (GNU Image Manipulation Program) 

o Krita 

 

 

 

GIMP  Krita 

 

 

(iii) Perisian Penghasilan ilustrasi 

 Berfungsi untuk menghasilkan ilustrasi grafik digital. 

 Biasanya perisian ini digunakan untuk membuat reka bentuk seperti 

logo, ilustrasi, karekter animasi, ikon dan imej grafik digital lain. 

 Antara format piawai yang selalu digunakan ialah AI, CDR, WMF dan 

FH. 

 Contoh perisian penghasilan ilustrasi berlesen: 

o Adobe Illustrator 

o Macromedia Freehand 

o Micrografx 

 



98 
 

 

 

 

 

 

Adobe Illustrator  
Macromedia Free 

Hand 
 

Micrografx 

Designer 

 

 

 Contoh perisian penghasilan ilustrasi sumber terbuka: 

o Inkscape 

o Xara LX 

o Open Office Draw 

 

 

 

 

 

 

Inkscape  Xara LX  
Open Office 

Draw 
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(iv) Perisian reka letak  

 Perisian reka letak berfungsi untuk menghasilkan bahan atau karya 

penerbitan meja. 

 Perisian reka letak berlesen: 

o QuarkXPress 

o Adobe InDesign (sebelum ini dikenali sebagai Adobe Pagemaker 

dan Adobe FrameMaker) 

o Microsoft Publisher 

 

 

 

 

 

 

QuarkXPress  Adobe Indesign  
Microsoft 

Publisher 

 

 Perisian reka letak sumber terbuka: 

o LaTeX 

o Scribus 

 

 

 

 

LaTeX  Scribus 
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6.1.4 MEMBANDING BEZA PENERBITAN MEJA BAGI MEDIA CETAK DAN MEDIA 

ELEKTRONIK 

 

PENERBITAN MEJA – MEDIA CETAK DAN MEDIA ELEKTRONIK 

1. Penerbitan meja boleh dijana dalam dua bentuk iaitu sama ada media cetak 

ataupun media elektronik. 

2. Berikut merupakan perbezaan antara kedua-dua jenis media tersebut. 

Media Cetak Media Elektronik 

 Bahan penerbitan yang 

disampaikan melalui bahan 

bercetak seperti surat khabar, 

majalah, katalog, risalah, 

kalendar, diari dan kad 

perniagaan. 

 Bahan penerbitan dalam bentuk 

secara elektronik e-majalah, 

e-akhbar, e-katalog, e-brosur dan 

lain-lain lagi. 

 

 Maklumat disimpan secara 

maujud. 

 Maklumat disimpan secara 

storan awan (cloud storage). 

 Sukar dikemaskini, perlu ulang 

cetak. 

 Boleh dikemaskini dengan cepat. 

 Sukar untuk mencari arkib dan 

bahan-bahan lama. 

 Mudah untuk mencapai bahan-

bahan di dalam arkib. 

 Merupakan media yang mudah 

disebarkan walaupun pengguna 

tidak mempunyai teknologi. 

 Memerlukan teknologi untuk 

membuat capaian oleh para 

pengguna. 

 Kualiti media cetak 

mempengaruhi kualiti penerbitan 

meja. 

 Kualiti paparan/audio 

mempengaruhi kualiti penerbitan 

meja. 
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AKTIVITI  

 

BAHAN DAN PERALATAN  

 

1. Internet 

2. Kertas A4 

3. Alat tulis 

 

TUGASAN  

Menghasilkan buku skrap karya penerbitan meja dan 

mencadangkan perisian dan perkakasan yang digunakan.  

 

 

 

LANGKAH KERJA (TUGASAN 1) 

 

1. Murid membuat kajian lapangan dengan mencari contoh-contoh 

karya penerbitan meja sedia ada.  

2. Murid menghasilkan buku skrap mengenai kajian lapangan tersebut. 

3. Murid mencadangkan perisian dan perkakasan yang digunakan untuk 

menghasilkan setiap satu contoh karya penerbitan meja.  

 

 

Anda kreatif? 

Buat satu lakaran bebas untuk menghasilkan karya penerbitan  

yang menarik yang bertemakan kanak-kanak. 
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LATIHAN / PENILAIAN 

 

Jawab semua soalan. 

 

1.Berikan definisi penerbitan meja. 

a. Alat yang direka untuk membantu pengguna untuk membuat kerja 

penerbitan dengan cepat dan mudah dan kelihatan profesional. 

b. Menentukan bentuk persembahan bahan promosi. 

c. Proses menyunting dan mereka letak bahan bercetak untuk tujuan 

penerbitan. 

d. Mengandungi banyak pilihan clipart, fon, foto dan perkataan, 

ditambah gambar yang canggih dan alat penyuntingan foto. 

 

2.Berikut adalah karya penerbitan meja KECUALI 

a. Poster 

b. Majalah 

c. Surat khabar 

d. Kad nama 

 

3. Berikut adalah perkakasan yang digunakan untuk menghasilkan karya 

penerbitan meja KECUALI: 

a. Kamera 

b. Pencetak 

c. Televisyen 

d. Pengimbas 
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4. Di bawah adalah contoh karya penerbitan meja iaitu: 

 
a. Risalah 

b. Kepala surat 

c. Sampul surat 

d. Brosur 

 

5. Perisian pemproses perkataan digunakan untuk kerja-kerja berikut KECUALI: 

a. Mengarang  

b. Memformat  

c. Mencetak dokumen  

d. Melukis karakter 

 

6. Berikan 4 jenis perisian penerbitan meja. 

a. ………………………………………………. 

b. ………………………………………………. 

c. ………………………………………………. 

d. ……………………………………………… 
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7. Senaraikan 2 perbezaan jenis penerbitan meja berikut. 

Media Cetak Media Elektronik 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8. Berikan 3 jenis perisian reka letak. 

a. …………………………………………….. 

b. …………………………………………….. 

c. …………………………………………….. 
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 LAPORAN PENCAPAIAN MURID  

Nama Murid  

Tahun  

Kelas  

 

Standard 

Kandungan 

6.1 Asas Penerbitan Meja 

Standard 

Pembelajaran 

6.1.1 Mengenal pasti definisi penerbitan meja.  

6.1.2 Memberi contoh karya penerbitan meja.  

6.1.3 Menerangkan keperluan perkakasan dan perisian 

penerbitan meja.  

6.1.4 Membanding beza penerbitan meja:  

(i) Media cetak  

(ii) Media elektronik 

 

Bil Perkara yang dinilai 

Pencapaian 

Catatan 
Terampil 

Belum 

Terampil 

1 Mentakrif definisi penerbitan meja.    

2 Menyenaraikan contoh karya penerbitan 

meja. 
  

 

3 Menyatakan keperluan perkakasan dan 

perisian penerbitan meja. 
  

 

4 Menyatakan perbezaan penerbitan meja 

menerusi media cetak dan elektronik.   
 

KEPUTUSAN 
(CAPAI / TIDAK CAPAI) 

TARIKH 

 

Nama Guru  Tandatangan & 

Tarikh 

 

Disahkan 

oleh 

 Tandatangan & 

Tarikh 

 

 

  



106 
 

MODUL 6.2 

 

Standard 

kandungan 
: 6.2 Pengolahan Idea karya Penerbitan Meja  

Standard 

pembelajaran 
6.1.     

: 6.2.1 Melaksanakan kajian lapangan berdasarkan keperluan 

penerbitan meja. 

6.2.2 Mencadangkan reka letak teks dan imej menerusi 

lakaran. 

6.2.3 Menghasilkan mekap contoh (mock-up) karya 

penerbitan meja. 

Objektif 

pembelajaran 
:  Membuat kajian lapangan berdasarkan keperluan 

penerbitan meja. 

 Menghasilkan lakaran reka letak teks dan imej. 

 Menghasilkan mekap contoh (mock-up) berdasarkan 

lakaran komprehensif. 

Masa : 24 jam 
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NOTA RUJUKAN 

6.2 PENGOLAHAN IDEA KARYA PENERBITAN MEJA 

 

6.2.1 MELAKSANAKAN KAJIAN LAPANGAN BERDASARKAN KEPERLUAN PENERBITAN 

MEJA 

 

Keperluan Penerbitan Meja 

Dalam proses penghasilan karya penerbitan meja, perkara utama yang perlu 

dikenal pasti ialah keperluan penerbitan meja. Antara keperluan penerbitan meja 

ialah jenis karya, media, perkakasan dan perisian, jenis bahan dan proses kemasan. 

 

 

A. Jenis Karya Penerbitan Meja 

   

Brosur Majalah Buku 

   

   

Katalog Surat khabar Buletin 
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B. Media Penerbitan Meja 

  

Media Cetak Media Elektronik 

 

C. Perkakasan dan perisian Penerbitan Meja 

i. Perkakasan 

  

Komputer Mesin Cetak 
  

  

Mesin Pengimbas Grafik tablet 
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ii. Perisian 

 Contoh perisian terbuka yang berada dalam pasaran. 

 

 

 
   

LaTex Scribus Canva 

   

 Contoh perisian berlesen yang boleh digunakan. 

   

Adobe Indesign Microsoft Publisher 
QuarkXpress 

 

 

 

D. Jenis bahan 

Jenis bahan merupakan keperluan yang penting untuk memastikan karya 

penerbitan meja yang ingin dihasilkan bersesuaian mengikut jenis karya. 

Antaranya adalah kertas.  

Spesifikasi kertas terbahagi kepada jenis, permukaan, berat, ketebalan dan saiz. 

Bagi ketebalan bawah 160gsm adalah dalam kategori kertas manakala 

160gsm ke atas disebut kad (board). 

Kertas- kertas ini akan diperolehi secara pukal dari kilang iaitu dalam bentuk stok 

kertas. 
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i. Kategori kertas 

 

Jenis: Art paper 

Permukaan: licin (glossy) 

Berat: Antara 80 gsm – 157 gsm 

Kegunaan: Risalah, brosur, poster, 

majalah 

  

 

Jenis: Simili paper 

Permukaan: kesat (matte) 

Berat: Antara 70 gsm – 100 gsm 

Kegunaan: Dokumen, resit, dan cetakan 

umum di pejabat 

 

 

Jenis: Conqueror paper 

Permukaan: tekstur kasar 

Berat: Antara 216 gsm – 446 gsm 

Kegunaan: Sijil, surat undangan, kad 

ucpan, menu restoran 

  

 

Jenis: Craft paper 

Permukaan: tekstur kasar 

Berat: Antara 157 gsm – 310 gsm 

Kegunaan: Kad kahwin 
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ii. Kategori kad 

 

Jenis: Art card 

Permukaan: licin (Glossy) dan Kesat 

(matte) 

Berat: Antara 230 gsm – 360 gsm 

Kegunaan: Kad perniagaan, poskad, kulit 

buku, katalog 

  

 

Jenis: Ivory card 

Permukaan: Kesat (matte) 

Berat: Antara 140 gsm – 209 gsm 

Kegunaan: Kad perniagaan, poskad, kulit 

buku, katalog 

  

 

Jenis: Linen card 

Permukaan: tekstur garisan halus dan 

cetakan timbul dengan corak crosshatch 

Berat: Antara 216 gsm – 446 gsm 

Kegunaan: Kad ucapan, kad nama, 

poskad, kulit buku atau nota dan menu 

restoran 
  

 

Jenis: Craft card 

Permukaan: tekstur berliang dan agak 

kasar 

Berat: Antara 40 gsm – 135 gsm 

Kegunaan: Kad ucapan, beg kertas dan 

pembungkusan produk 
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E. Proses Kemasan 

 Potong dan pangkas (Cutting and Trimming) 

 
 

 

Stok kertas perlu dipotong atau dipangkas mengikut saiz yang dikehendaki. 

Ukuran kertas yang terlalu besar perlu dipotong dan disisirkan mengikut 

ukuran mesin yang akan digunakan. Apabila sesuatu produk contohnya 

buku, majalah, brosur atau risalah siap dicetak, kerja memotong dan 

memangkas bahagian yang tidak diperlukan akan diulang untuk 

mendapatkan ukuran yang sebenar dan tepat. 
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 Potong terap (die cut) 
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 Proses pelipatan (folding) 

Proses pelipatan bergantung kepada jenis penjilidan dan bilangan halaman 

suatu karya. Berikut merupakan contoh lipatan mengikut bilangan halaman. 

   
4 halaman 6 halaman 8 halaman 

   

   
10 halaman 12 halaman 16 halaman 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://qrgo.page.link/bo6p8 

Jenis-jenis lipatan brosur 

https://qrgo.page.link/bo6p8
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 Penjilidan (binding) 

Proses penjilidan terbahagi kepada beberapa jenis iaitu: 

   

Jilid sempurna 

(perfect binding) 

Jahitan 

(stiching) 

Jilid gegelung 

(Ring binding) 

   

  

 

Jilid sisir 

(comb binding) 

Jilid pilin 

(spiral binding) 

Jilid pita 

(tape binding) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
https://qrgo.page.link/T8rHY 

 

Jenis-jenis penjilidan 

https://qrgo.page.link/T8rHY
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6.2.2 MELAKSANAKAN KAJIAN LAPANGAN BERDASARKAN KEPERLUAN PENERBITAN 

MEJA 

 

Kajian Lapangan Berdasarkan Keperluan Penerbitan Meja 

Dalam proses kajian lapangan, pereka akan membuat kajian berdasarkan 

keperluan penerbitan meja untuk mendapatkan konsep dan idea yang diperlukan 

bagi mencipta idea baharu dan menarik. 

Pereka akan membuat kajian berdasarkan jenis karya, media, perkakasan dan 

perisian, jenis bahan serta proses kemasan yang akan digunakan melalui sumber 

laman sesawang, majalah, buku dan lain-lain. 

 

 

Contoh Kajian Lapangan berdasarkan karya penerbitan meja 

Jenis Karya: Brosur  

Jenis Media: Media cetak 

Ukuran: 29.7cm x 21cm (A4) 

Tajuk: Seni Kraf Batik Malaysia 

Tema: Batik Kontemporari 

Sumber bahan: Laman sesawang, majalah, buku dan lain-lain. 

 

1. Koleksi pelbagai brosur sebagai sumber ilham 
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2. Kajian jenis lipatan brosur 

 
 

3. Koleksi gambar seni kraf batik sebagai sumber ilham 
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6.2.3 MENCADANGKAN REKA LETAK TEKS DAN IMEJ MENERUSI LAKARAN 

 

A. Membuat lakaran kecil (thumbnail) 

Sebelum memulakan lakaran kecil, jenis lipatan brosur perlu dikenal pasti untuk 

menentukan lipatan dan susunan halaman bagi memudahkan pengolahan 

idea reka letak teks dan imej yang sesuai. 

 

 
Lakaran kecil 
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B. Membuat lakaran kasar 

Setelah memilih satu lakaran kecil yang terbaik, idea tersebut akan dilakar 

dengan lebih jelas supaya pemilihan teks, imej atau ilustrasi yang sesuai dapat 

dikenal pasti. 

Contoh lakaran kecil idea 4 menjadi pilihan. 

 
Lakaran kasar 
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C. Membuat lakaran komprehensif 

Berasaskan lakaran kasar, lakaran komprehensif dibuat dengan lebih teliti 

menyerupai reka letak akhir iaitu mempunyai tajuk, visual dan kandungan teks 

seperti yang akan dipaparkan atau menggunakan taip dummy sebagai ganti. 

Selain itu, tajuk dan kandungan teks menggunakan fon sebenar dan garisan 

grid digunakan bagi memastikan semua elemen disusun dengan tepat. 

 

                       

  

 

 

 

 

 

 

 

 

 

 

 

 

 

       Lakaran komprehensif 
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6.2.4 MENGHASILKAN MEKAP CONTOH (MOCK-UP) KARYA PENERBITAN MEJA 

 

MEKAP CONTOH (MOCK-UP) 

Penghasilan mekap contoh sangat penting dalam sesuatu reka bentuk bagi 

melihat hasil sebelum dipapar secara digital atau dicetak supaya dapat memberi 

paparan visual sehingga mendapat gambaran hasil yang menyerupai hasil 

sebenar. 

 

 

 

      Mekap contoh brosur 

 

 

 

 

 
Hadapan 

 

 
Belakang 

 

 
https://qrgo.page.link/SgRvr 

 

Mekap contoh digital 
 

https://qrgo.page.link/SgRvr
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AKTIVITI  

 

BAHAN DAN PERALATAN  
1. Pensel 

2. Rendering marker 

3. Kertas lukisan 

 

 

TUGASAN  
Murid menghasilkan kulit majalah berdasarkan tema yang 

telah ditetapkan oleh guru dengan menggunakan peralatan 

yang bersesuaian.  
 
 

 

LANGKAH KERJA (TUGASAN 1) 
1. Murid melaksanakan kajian lapangan berkaitan kulit majalah dengan tema 

yang telah ditetapkan. 

2. Murid membuat lakaran kecil, lakaran kasar dan lakaran komprehensif kulit 

majalah yang akan dihasilkan. 

3. Murid menghasilkan mekap contoh (mock-up) berdasarkan lakaran 

komprehensif. 

4. Murid mempamerkan hasil karya. 

 

 

 

 

Anda kreatif? 
Buat proses pengolahan idea untuk menghasilkan buku 

mewarna kanak-kanak bertemakan haiwan fantasi. 
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LATIHAN / PENILAIAN 

 

Jawab semua soalan 

1. Rajah 1 menunjukkan mekap contoh bagi karya penerbitan meja  

 
Rajah 1 

 

 

Nyatakan tiga jenis kertas yang sesuai untuk menghasilkan mekap contoh 

tersebut. 

…………………………….……………………................................................................... 

 

 

…………………………………………………………………………………………………… 

 

 

…………………………………………………………………………………………………… 
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2. Jadual 1(a) menunjukkan jenis lipatan kertas dan Jadual 1(b) menunjukkan 

produk akhir lipatan yang dihasilkan.  

Jenis Lipatan 

Half-Fold Single Gate Fold Z-Fold Tri-Fold 

Jadual 1(a)   

 

Padankan jenis lipatan kertas pada Jadual 1(a) dengan produk akhir lipatan 

yang dihasilkan pada ruang jawapan yang disediakan.  

 

 

Produk Akhir Lipatan Ruang Jawapan 

  

  

  

  

 

Jadual 1(b) 
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LAPORAN PENCAPAIAN MURID 

 

Nama Murid  

Tahun  

Kelas  

 

Standard 

Kandungan 

6.2 Pengolahan Idea karya Penerbitan Meja  

Standard 

Pembelajaran 

6.2.1 Melaksanakan kajian lapangan berdasarkan keperluan 

penerbitan meja. 

6.2.2 Mencadangkan reka letak teks dan imej menerusi 

lakaran. 

6.2.3 Menghasilkan mekap contoh (mock-up) karya 

penerbitan meja. 

 

Bil Perkara yang dinilai 

Pencapaian 

Catatan 
Terampil 

Belum 

Terampil 

1 Membuat kajian lapangan 

berdasarkan keperluan penerbitan 

meja 

  

 

2 Menghasilkan lakaran reka letak teks 

dan imej 
  

 

3 Menghasilkan mekap contoh (mock-

up) berdasarkan lakaran 

komprehensif 

  

 

KEPUTUSAN 
(CAPAI / TIDAK CAPAI) 

TARIKH 

 

Nama Guru  Tandatangan & 

Tarikh 

 

Disahkan 

oleh 

 Tandatangan & 

Tarikh 
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MODUL 6.2 

 

Standard 

kandungan 

: 6.3 Penghasilan karya penerbitan meja 

Standard 

pembelajaran:  

 6.3.1 Menjelaskan fungsi alat dan fitur dalam perisian 

penerbitan atas meja 

6.3.2 Membuat penetapan dokumen: 

(i) Saiz halaman dan margin 

(ii) Grid dan lajur 

(iii) Halaman utama (master page) 

(iv) Palet warna 

(v) Stail perenggan  

6.3.3 Menyisip dan menyusun teks dan imej dengan 

menggunakan alat dan fitur yang sesuai 

6.3.4 Menghasilkan karya penerbitan meja dengan 

mengaplikasikan fitur: 

(i) Pengepala dan Pengaki (Header and footer) 

(ii) Tajuk Silang dan Tajuk samping (Crosshead and 

sidehead) 

(iii)  Pull-quote 

(iv) Pengengsotan (Indentation) 

(v) Penjajaran (Alignment) 

(vi) Wrapping  

(vii) Hyphenation  

(viii) Drop cap 

6.3.5 Menyediakan fail untuk proses prepress 

6.3.6 Mencadangkan jenis penjilidan yang bersesuaian 

dengan hasil karya penerbitan meja 

6.3.7 Mencetak dan melaksanakan proses kemasan (finishing) 

hasil karya akhir penerbitan 
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Objektif 

pembelajaran 

3. : ▪ Menjelaskan fungsi alat dan fitur di dalam perisian 

penerbitan atas meja 

▪ membuat penetapan saiz halaman, grid lajur, master page, 

palet warna dan stail perenggan pada dokumen  

▪ menyisip dan menyusun teks serta imej  

▪ menghasilkan karya penerbitan meja dengan 

mengaplikasikan fitur 

(i) Pengepala dan Pengaki  

(ii) Tajuk Silang dan Tajuk samping  

(iii) Pull-quote 

(iv) Pengengsotan 

(v) Penjajaran 

(vi) Wrapping 

(vii) Hyphenation  

(viii) Drop cap 

 Menyediakan format fail untuk proses prepress 

 Menyenaraikan jenis penjilidan yang bersesuaian dengan 

hasil karya penerbitan 

 Membuat proses kemasan (finishing) hasil karya akhir 

penerbitan 

 

Masa 4. : 38  jam 
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 NOTA RUJUKAN  

6.3 PENGHASILAN KARYA PENERBITAN MEJA 

 

Pendahuluan 

Dalam menjelaskan fungsi alat dan fitur dalam perisian penerbitan atas meja, 

perisian yang selalu digunakan ialah MS Publisher. Segala alat dan menu arahan di 

dalam MS Publisher dikenali sebagai fitur antara muka MS Publisher. 

 

6.3.1 MENJELASKAN FUNGSI ALAT DAN FITUR DALAM PERISIAN PENERBITAN ATAS 

MEJA 

Dalam menjelaskan fungsi alat dan fitur dalam perisian penerbitan atas meja, 

perisian yang selalu digunakan ialah MS Publisher. Segala alat dan menu arahan di 

dalam MS Publisher dikenali sebagai fitur antara muka MS Publisher.  

 

Terdapat 3 bahagian penting dalam perisian MS Publisher iaitu The Ribbon, Quick 

Access dan File Menu. MS Publisher juga mempunyai bahagian utama yang lain. 

 

THE RIBBON 

Berada di bahagian atas, mempunyai ke semua arahan Publisher dan disusun 

kepada 3 bahagian: 

 Tabs - mewakili segala area aktiviti. 

 Groups - menunjukkan alat arahan (command) yang berkaitan 

bersama. 

 Command - butang (button), menu yang dapat dikembangkan atau 

kotak untuk memasukkan maklumat yang berkaitan. 
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Klik pada pelbagai menu (Tabs): perhatikan bagaimana kumpulan dan arahan 

berubah berdasarkan menu yang dipilih. 

 
 

 

 

 

 

QUICK ACCESS BAR 

Bahagian ini terletak di atas bahagian menu (Tabs) dan arahan yang kerap 

digunakan (command use most often) termasuk arahan Save. Terdapat pelbagai 

alatan pada bahagian ini di mana pengguna boleh mengakses alatan dengan 

mudah dan pantas. 

 Arahan Undo atau dikenali sebagai ‘mengambil kembali’ di mana sebarang 

perubahan yang dibuat pada dokumen akan dikembalikan pada keadaan 

yang sebelumnya. 

 Arahan Save pula digunakan untuk menyimpan hasil kerja yang telah dibuat. 

 

 
 

 

 

 

 

 

 

 

 

 

Rajah bahagian THE RIBBON 

Rajah bahagian Quick Access Toolbar dan arahan UNDO 
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FILE MENU 

Bahagian ini mengandungi arahan pada fail setiap tahap. Pada bahagian kiri 

menu (Tabs) terdapat menu File.  

 
Rajah File Menu 

 

 

Antara fungsi arahan yang ada pada  menu File: 

 New  - Cipta dokumen baharu 

 Open - Buka dokumen yang telah dibuat sebelum ini 

 Save - Simpan perubahan pada dokumen semasa 

 Save as - Simpan sebagai fail lain dengan nama yang berbeza 

 Info   - Mengandungi maklumat dokumen 

 Print - Mencetak dokumen 

 Share  Menghantar dan berkongsi dokumen 

 Export - mengeksport dokumen dalam bentuk fail yang lain 

 Close - Tutup dokumen yang telah dicipta 

  

 

 

 

 

 

 

 

 

 
Menu “File” 

 

Tahukah anda 

maklumat tambahan 

berkenaan dengan 

menu 

 

Sila imbas Kod QR 
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ALATAN ORGANISASI DALAM PERISIAN MS PUBLISHER 

Dalam perisian MS Publisher menawarkan banyak alat untuk membantu mengatur 

dan menyusun kandungan dalam penerbitan. Alatan tersebut terdapat pada 

arahan menu View. Pengguna boleh memilih 6 fitur alatan organisasi yang selalu 

digunakan: 

 
Rajah menu View bagi pilihan bagi alatan organisasi pada dokumen 

 

 

1. Baselines 

Garis dasar adalah garis mendatar yang sama jaraknya yang dapat digunakan 

untuk menyusun teks.  

 

2. Boundaries 

Batas adalah sempadan putus-putus biru gelap yang muncul di sekitar objek. 

Melihat batas objek boleh berguna untuk menyelaraskan objek atau melihat 

teks. 

 

3. Rulers 

Pembaris berada di sebelah kiri dan atas penerbitan untuk membantu 

menyusun teks, gambar, dan objek lain. Apabila objek dipilih, ruang putih akan 

muncul pada pembaris untuk menunjukkan lokasi objek. 
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4. Guides 

Panduan adalah garis nipis yang membantu menyelaraskan objek. Terdapat 

dua jenis panduan: 

 

 Margin Guides 

Petunjuk margin adalah garis biru yang menandakan tepi, atau margin, dari 

kawasan yang boleh dicetak; dibuat secara automatik apabila margin 

halaman ditetapkan. 

 

 Customizable Guide 

Panduan yang dapat disesuaikan adalah garis hijau yang dapat 

ditambahkan di mana saja dalam penerbitan. 

 

5. Page Navigation 

Navigasi Halaman adalah panel di sebelah kiri yang memaparkan gambar 

setiap halaman dalam penerbitan. 

 

6. Scratch Area 

Kawasan kelabu di luar kawasan halaman putih. Kawasan ini menunjukkan 

objek atau bahagian objek yang terletak di luar sempadan halaman. Apa 

sahaja di kawasan kelbu tidak akan dicetak. Pengguna boleh 

menganggapnya sebagai ruang sementara sebelum memutuskan untuk 

meletakkan dan bagaimana meletakkannya dalam penerbitan. 
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Rajah alatan organisasi dalam penerbitan 

  



134 
 

Fungsi arahan dan alatan pada menu (Tabs) MS Publisher mengikut kumpulan  

1. Menu Home 

          

 
Rajah menu Home 

 

 

Berikut merupakan kumpulan arahan dan perlakuan bagi alatan dan fitur MS 

Publisher pada menu Home: 

 Clipboard - mengandungi alat yang selalu digunakan pada 

dokumen contoh Cut, Paste dan Copy. 

 Font - mengandungi segala keluarga font serta format fon. 

 Paragraph - mengandungi format perenggan. 

 Style - mengandungi gaya penulisan. 

 Object - mengandungi objek yang hendak dimasukkan dalam 

halaman 

 Arrange - mengandungi arahan dan alat untuk menyusun 

maklumat pada halaman. 

 Editing - mengandungi arahan untuk penyuntingan pada 

dokumen. 
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2. Menu Insert 

       

 
Rajah menu Insert 

 

 

 

Berikut merupakan kumpulan arahan dan perlakuan bagi alatan dan fitur MS 

Publisher pada menu Insert: 

 Pages - mengandungi fitur arahan bagi bentuk halaman. 

 Table - mengandungi fitur alatan untuk membuat jadual. 

 Ilustrations - mengandungi fitur ilustrasi bagi halaman. 

 Building Block - mengandungi fitur kandungan yang boleh 

digunakan semula. 

 Text - mengandungi fitur alatan untuk perkataan. 

 Link - mengandungi alat hubung atau rangkaian. 

 Header and Footer - mengandungi arahan untuk penyuntingan pada 

Pengepala dan Pengaki 
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3. Menu Page Design 

   
Rajah menu Page Design 

 

Berikut merupakan kumpulan arahan dan perlakuan bagi alatan dan fitur MS 

Publisher pada menu Page Design: 

 Template - mengandungi fitur bagi templat halaman. 

 Page Setup - mengandungi arahan dan alat untuk persediaan 

halaman. 

 Layout - mengandungi alatan susun atur halaman. 

 Page - mengandungi alatan bagi suntingan halaman. 

 Scheme - mengandungi fitur skema warna bagi halaman. 

 Page Background - mengandungi alatan untuk latar belakang               

halaman.   

 

 

 

 

4. Menu Mailing 

 

   
Menu (Tabs) Mailing 

 

Berikut merupakan kumpulan arahan dan perlakuan bagi alatan dan fitur MS 

Publisher pada menu Mailing: 

 Start - mengandungi alat gabungan bagi mencetak 

sampul surat atau label. 

 Write & Insert 

Fields 

- mengandungi alat untuk memasukkan penulisan 

dan medan berbeza. 

 Periview Results - mengandungi arahan papar keputusan atau 

data. 

 Finish - mengandungi arahan dan alat penyudah bagi 

gabungan. 
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5. Menu Review 

 
Menu Review 

Berikut merupakan kumpulan arahan dan perlakuan bagi alatan dan fitur MS 

Publisher pada menu Review: 

 Proofing - mengandungi fitur alat pembuktian, menyemak 

kesalahan teks dan maksud perkataan yang 

digunakan pada dokumen  

 Language - mengandungi fitur arahan pada bahasa yang 

digunakan. 

 

 

 

6. Menu View 

  
Menu View 

 

Berikut merupakan kumpulan arahan dan perlakuan bagi alatan dan fitur MS 

Publisher pada menu View: 

 Views - mengandungi fitur paparan keseluruhan dokumen. 

 Layout - mengandungi arahan paparan susun atur dokumen. 

 Show - mengandungi paparan fitur format arahan dan alat bagi 

keseluruhan bahagian dokumen yang hendak digunakan 

atau tidak digunakan. 

 Zoom - mengandungi fitur mengezum pada dokumen. 

 Windows - mengandungi fitur paparan windows. 
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7. Menu Help 

 
Menu Help 

 

 

Berikut merupakan kumpulan arahan dan perlakuan bagi alatan dan fitur MS 

Publisher pada menu Help. 

 Help - mengandungi arahan dan fitur bantuan serta maklum 

balas. 

 

 

 

 

 

6.3.2 MEMBUAT PENETAPAN DOKUMEN 

PENETAPAN DOKUMEN 

(i) Saiz halaman dan margin 

 (a) Aktifkan perisian MS 

Publisher > klik pada 

menu New > More Blank 

Page Sizes> pilih saiz A4. 

   

 

 

 

More Blank Page Size 

Pilihan saiz A4 
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 (b) Klik pada menu Page 

Design > ubah tetapan 

kepada Moderate. 

 

 

 

 

 

 

 

 

 

 

 

 

(ii) Grid dan lajur 

 (a) Klik pada menu Page 

Design > Guides > Layout 

Guides > ubah tetapan 

kepada 0.5 untuk setiap 

margin. 

 

 

 

 

 

 

 

 

 

 

 

 

 (b) Klik pada tab Grid Guides 

> ubah tetapan Column 

Guides kepada 2, Row 

Guides kepada 2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Moderate 

Margins 
Page Design 

Margin 

Guides 

Grid 

Guides 
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(iii) Halaman utama (master page) 

 (a) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Klik pada menu Page 

Design > Master Page > 

Edit Master Pages. Ubah 

Pengepala dan Pengaki 

(header dan footer). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

(iv) Palet warna 

 (a) Untuk tetapan palet warna, klik pada Page Design > pilih tetapan 

warna built-in > Aspect. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Edit Master 

Pages 

 

Master 

Pages 

Page Design 

Aspect  
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(v) Stail perenggan 

 

 

 (a) Klik pada Home > Styles > 

New Styles > Namakan 

style baharu, pilih jenis 

muka taip yang 

diperlukan. tetapan 

paragraph juga dibuat 

dengan menetapkan 

Alignment > Justified. 

 

 

 
 

  

 
 

New Style 

Name Allignment 

 

Imbas QR 

untuk muat 

turun 

bahan 

Sila imbas Kod QR 

BAHAN AKTIVITI 
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6.3.3 MENYISIP DAN MENYUSUN TEKS DAN IMEJ  

 

(i) Menyisip dan Menyusun teks 

 a) Klik menu Insert > Draw Text 

Box > seretkan tetikus untuk 

menghasilkan kotak teks. Isi 

kotak teks dengan teks 

yang telah disediakan.  

 

 

 

 

 

 

 

 

 

 

 

 (b) Pada bahagian tajuk, klik 

pada menu Insert > Page 

Part > pilih Heading yang 

sesuai > ubah tetapan teks 

kepada “RESIPI NASI 

AYAM”, Resipi: Puan 

Kalsom. 

 

 

 

 

 

 

 

 

 (c) Hasil tajuk dan teks seperti 

rajah di sebelah. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

Draw Text Box 

 

Page Parts 

 

Insert 

 RESIPI NASI AYAM 
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(ii) Menyisip dan menyusun imej 

 (a) Klik pada menu Insert > 

Pictures > pilih imej yang 

diperlukan > tekan butang 

Insert.  

 

 

 

 

 

 

 

 

 

 

 

 

 (b) Dwi klik pada imej yang 

telah disisip > klik pada 

menu Format > Crop > 

sunting imej nasi ayam 

seperti di dalam rajah di 

sebelah.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 (c) Imej yang telah dipotong 

akan dikecilkan saiz yang 

bersesuaian dengan reka 

letak (layout). 

 
  

 

 
Insert 

Insert 

 

 

 

Crop  

Crop 

Section 
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Hasil awal penerbitan meja muka surat buku menu. 

 
 

 

Tajuk 

Teks yang belum dibuat 

penjajaran dan pengengsotan 

Imej yang belum 

diubah imej wrapping 
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6.3.4 MENGHASILKAN KARYA PENERBITAN MEJA DENGAN MENGAPLIKASIKAN FITUR 

YANG DIBERIKAN 

 

Langkah Kerja menghasilkan penerbitan meja mukasurat dalaman majalah 

(i) Pengepala dan Pengaki (Header and footer) 

 a) Klik pada menu Insert > Header. 

 b) Taip perkataan “Selera Asia” pada Header. Ubah tetapan jenis teks 

dan saiz teks. Tetapkan alignment teks kepada Right.  

 

 

 
 c) Klik pada menu Insert > 

Footer. Taip perkataan 

“Majalah Selera Asia | Edisi 

Disember 2020”. Ubah 

tetapan teks seperti di 

langkah (b). Tetapkan 

alignment teks kepada 

Center. 

 

 

 
 

(ii) Tajuk Silang dan Tajuk Samping (Crosshead and sidehead) 

 

 

 (a) Untuk Tajuk Samping, klik pada menu Format > Draw Text Box > taip 

ayat “Bahan – Bahan untuk Sup Ayam / Kuah Kicap dan Kuah Cili”. 

Seretkan kotak teks ke sebelah kiri. 

               
 (b) Ulang langkah (a) untuk kotak kedua dengan memasukkan teks 

“Bahan -  bahan untuk Nasi” 

 

1. Insert 

2. Header & 

footer 
 

 

3. Taip teks header 

 

3. Taip teks footer 

1. Format 

 

 

 2. Draw text box 

3. Kotak text 

box 

3. Kotak text 

box 
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 (c) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Untuk tajuk Silang pula, highlight pada tajuk “Cara Memasak” ubah 

alignment Left kepada Center dan tetapan Underline. Ulang langkah 

(c) untuk teks “Cara Memasak” yang kedua seperti rajah di bawah.   

 

 

 

 

(iii) Pull-quote 

 (a) Klik menu Insert > Page 

Parts > Pull Quotes > 

taip teks “Makanan 

yang dibuat sendiri itu 

kita boleh rasa kasih 

sayangnya”. 
 
 

 

 

 

 

 

 

 

 

 (b) Laraskan saiz dan jenis 

teks. Ubah saiz text box 

dan laraskan 

kedudukan pada 

perenggan teks kedua. 

 

 

 

 

 
 

Align > Center 
Bold & 

Underline 

Crosshead 

Insert 

 

 

Page 

Parts 

Pull Quotes 

 

 

Pull Quotes 



147 
 

(iv) Pengengsotan (Indentation) 

 (a) Pilih kesemua teks pada perenggan 1 dan 2 > klik pada menu Home 

> Decrease Indent Position. 

 

  

           
 
 
 
 

(v) Penjajaran (Alignment) 

 (a) Pada bahagian ini, penjajaran Justify digunakan pada susunan teks 

supaya lebih kemas. Klik pada menu Home > klik Justify di bahagian 

Paragraph. 

 (b) Untuk bahagian senarai bahan - bahan, penjajaran Align Text Left 

digunakan. Klik pada menu Format > Align Top Left di bahagian 

alignment.  

   

   
 

 

 

 

 

 

 

 

1. Highlight Teks 

2. Decrease Indent 

Position 

 

 

1. Highlight Teks 

2. Allign Top 

Left  
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(vi) Wrapping 

 (a) Fungsi Wrapping 

digunakan pada imej. 

Highlight pada imej > 

Klik pada menu Format 

> Wrap Text > Square. 

 
 

 (b) Laraskan imej di 

sebelah kiri. Hasil seperti 

imej yang terdapat 

pada bulatan di 

bawah.  

 

 

 

 

 

 

 

 

 

 

 

 

(vii) Hyphenation 

 (a) Buat tetapan Align > Justify akan menampakkan rongga-rongga 

yang bersepah apabila ruang column yang lebarnya kecil dan 

tiada hyphenation. Selain itu dash (-) juga akan kelihatan banyak 

pada hujung baris teks.  

 (b) Untuk menghilangkan dash (-) 

seperti di dalam bulatan di 

sebelah, Hyphenation 

digunakan.  

 

 

 

 

 

 

 

 

 

 

 

3. Wrap 

Text 
 

 

 

2. Format 

4. Square 

1. Highlight 

Imej 

 

 

dash (-) 
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 (c) Klik pada menu Format 

> Hyphenation > ubah 

tetapan Hyphenation 

zone kepada nilai 2.   
 
 
 
 
 
 
 
 
 
 

 
 
 

 

 

 

(viii) Drop Cap 

 (a) Drop Cap adalah suatu cara untuk menjadikan huruf pertama pada 

perenggan agar terlihat lebih besar jika dibandingkan huruf-huruf 

lain. Fitur Drop Cap digunakan agar teks lebih artistik dan menarik 

ketika dilihat oleh pembaca. 

 

 (b) Klik pada menu Format > Drop 

Cap > pilih jenis Drop Cap 

yang bersesuaian dengan teks 

dan jenis muka taip yang 

digunakan. Huruf N pada 

perenggan pertama akan 

menjadi besar daripada saiz 

asal.  

 

 

 

 

 

 

 

 

 

 

 

 

2. Hyphenation 

1. Format 

3. Ubah nilai 

1. Format 

 
 

 

2. Drop 

Cap 

3. Pilihan Drop 

Cap 
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Hasil akhir penerbitan meja muka surat buku menu. 

 
 

 

 

 

 

 

 

 
 

Header 

Tajuk 

Drop Cap 

Alignment, Justify & 

Hyphenation 

Pull Quote 

Wrapping 

Footer 

Alignment 

Justify & 

Hyphenation 

 
Crosshead 

 Crosshead 

 

Sidehead 

 

Sidehead 
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6.3.5 MENYEDIAKAN FAIL UNTUK PROSES PREPRESS 

 

PROSES PREPRESS 

 

PENGENALAN 

Prepress merujuk kepada proses kolektif yang mengubah dan menyediakan susun 

atur cetakan komputer untuk percetakan akhir (di mesin cetak).  

Proses ini mentakrifkan semua proses yang berlaku selepas pereka grafik telah 

membuat fail reka bentuk sehingga ia siap untuk dicetak. 

Proses prepress diperlukan kerana susunan cetak komputer yang dihasilkan 

mungkin kelihatan berbeza dalam penjajaran, format dan warna jika ia dicetak 

terus pada mesin akhbar.  

 

PROSES PREPRESS 

Prepress biasanya melibatkan proses berikut: 

1. Memeriksa dan mengesahkan fail reka bentuk untuk format, fon dan resolusi. 

2. Memastikan kod warna komputer yang dihasilkan dengan kod warna cetak 

adalah bersesuaian. 

3. Menyelaraskan format susun atur untuk dicetak. 

4. Membuat sampel  reka bentuk sebelum ia dicetak. 
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Langkah-langkah Prepress 

 

 

 

 

  

• Proses memeriksa semua elemen yang ada 
dalam reka bentuk (grafik, fon, garis, warna dan 
lain-lain). 

• Menyediakan fail PDF untuk ke proses berikutnya.
Refining

• Proses mencetak reka bentuk ke pencetak 
digital untuk memeriksa sama ada hasil sesuai 
seperti kemahuan pelanggan.

• Hasil proofing akan disemak oleh pelanggan 
dan menjadi panduan kepada operator mesin.

Proofing

• Proses menyusun halaman-halaman pada ruang 
cetak untuk perletakan yang betul apabila 
bahan dilipat ataupun dipotong.Imposition / Step & 

Repeat

• Proses untuk mengubah data digital menjadi 
data raster/blok yang akan diletakkan pada plat 
cetak bagi pemisahan warna untuk plat masing-
masing.

• Format fail adalah dalam bentuk TIF.

RIP (Raster Image 
Prosessing) 

• Proses menukarkan fail TIF menjadi plat dengan 
Computer to Plate (CTP)yang menggunakan 
laser untuk“melukis” pada plat baru sehingga 
reka bentuk terhasil pada plat berasingan.

Plate Processing



153 
 

6.3.6 MENCADANGKAN JENIS PENJILIDAN YANG BERSESUAIAN DENGAN HASIL 

KARYA PENERBITAN MEJA 

Pengenalan  

 

Penjilidan buku mengalami perubahan dari tahun ke tahun. Pada mulanya buku 

konvensional yang dibuat daripada lembaran papirus (sejenis tumbuhan) kepada 

kulit binatang hinggalah lembaran daun yang telah dikeringkan. 

Kandungannya dilipat kemudian disusun menjadi beberapa bahagian yang sesuai 

dengan ukuran yang ditentukan dan susunan tersebut dijahit hingga menjadi 

sebuah buku. 

Teknik penjilidan buku dapat dilakukan dengan beberapa jenis penjilidan kerana 

jenis teknik penjilidan memiliki kegunaan masing masing dalam keperluannya. 

Contoh: sebuah buku tebal lebih dari seratus halaman biasanya menggunakan 

teknik jilid benang atau jilid keras agar buku tidak cepat rosak. 

Teknik penjilidan buku juga memiliki fungsi yang bertujuan untuk meningkatkan imej 

buku itu sendiri, contohnya jika menggunakan kulit keras, ia menampakkan 

kemewahan dan eksklusif dan pengguna akan lebih tertarik untuk membuka dan 

melihat lihat buku tersebut. 

 

Jenis Perjilidan 

Perfect binding  

 Jenis penjilidan Perfect yang menggunakan gam panas di mana pada 

proses pembuatannya memiliki satu sisi lembaran kertas yang menjadi buku 

agar gam dapat masuk dengan sempurna dan merekat pada lembaran 

kertas.  

 Terdapat dua jenis iaitu yang biasa dan yang dijahit dengan benang. 

 Boleh menggunakan soft cover atau pun hard cover contohnya pada 

laporan tahunan, majalah dan novel. 
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Mesin untuk penjilidan perfect binding 

 

 

1. Saddle stiching  binding 

 Jenis penjilidan saddle stiching yang menggunakan dawai kokot.  

 Lembaran kertas dilipat mejadi dua kemudian pada bahagian tengahnya 

diletakkan dawai kokot sebagai  pengikat. 

 
Contoh penjilidan saddle stiching 

 

2. Loop stitching  binding 

 Jenis penjilidan loop stitching memiliki persamaan dengan jenis penjilidan 

buku saddle stitching. Perbezaan penjilidan jenis loop stiching dengan saddle 

stitching ialah pada bahagian luar buku dawai kokotnya memiliki bentuk 

yang melengkung pada suatu lubang.  

 Fungsi pada dawai kokot melengkung yang berlubang ialah agar buku 

dapat dimasukkan dalam binder yang besar.  

https://2.bp.blogspot.com/-6ACthI5l1l8/XIHmSNNJjyI/AAAAAAAAAGY/GHsHWOqFj0oIycYDuS-IaSV0ybqbs5PAwCLcBGAs/s1600/5071629_20130114033042.jpg
https://1.bp.blogspot.com/-s1zgfqGvRFE/XIHon5sK-SI/AAAAAAAAAGw/Tn7OdNCBQNog0n331EF3b2YR3ZImNnp0gCLcBGAs/s1600/Saddle-stitched-A4-portfolio-closeup-5_1024x1024.jpg
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 Selalunya jilid ini digunakan di dalam syarikat yang mempunyai katalog yang 

perlu disimpan di dalam fail. 

 
Contoh penjilidan loop stitching 

 

3. Screw binding  

 Jenis penjilidan ini menggunakan skru untuk menyatuhkan lembaran-

lembaran pada sebuah buku. Kertas ditebuk dari halaman pertama hingga 

ke halaman belakang.  

 Biasanya ia digunakan dalam hard cover, kalatog warna dan buku menu. 

 
Contoh penjilidan screw 
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4. Side stitching binding 

 Jenis penjilidan side stitching hampir sama dengan saddle stitching yang 

menggunakan dawai kokot atau benang.  

 Penjilidan ini biasanya digunakan untuk menjilid dokumen yang tebal. 

 
Contoh penjilidan side stitching 

 

5. Tape binding 

 Menggunakan pita pelekat hitam yang ditampalkan pada bahagian tepi 

buku. 

 Kos sangat rendah dan biasanya digunakan oleh pelajar sekolah dan 

universiti 

 Mudah rosak 

 
Contoh penjilidan tape 
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6. Case binding  

 Penjilidan ini dilakukan dengan cara menyusun buku yang telah dijahit dan 

digam pada bahagian hujung kertas dan ditampalkan pada kulit keras. 

 Teknik ini merupakan piawai yang sering dipakai pada penyusunan buku, 

karya ilmiah atau projek akhir. 

 
Contoh penjilidan case 

 

7. Plastic grip binding 

 Jenis penjilidan plastic grip ini merupakan bahan utama yang digunakan 

dalam teknik penjilidan. 

 Penjilidan ini ringkas dan mudah kerana dapat menyusun dokumen yang 

diingini dan disatukan menggunakan plastik. 

 Teknik ini dapat digabungkan dengan teknik side stitching ataupun dijilid 

pada bahagian tepi dokumen sebelum memasukkan plastik tersebut agar 

tahan lebih lama. 

 
Contoh penjilidan plastic grip 

 

 

 

 

 

https://1.bp.blogspot.com/-YS4WgD1BrYg/XIHzljY7a4I/AAAAAAAAAHo/QSSfKXhf8c8vItDrSk6c9jLoBaqb-XoKgCLcBGAs/s1600/flat-spine-case-binding.jpg
https://3.bp.blogspot.com/-wxdlpM8rPTc/XIH184Nbg3I/AAAAAAAAAH0/AKj6DmtHZowMAkYuAVA8qvNAhWyZIy1kwCLcBGAs/s1600/Slide_Binders.png


158 
 

8. Comb binding (jilid spiral) 

 Menggunakan bahan plastik yang tidak terlalu tebal (di bawah 100 

halaman).  

 Biasanya ditambahkan plastik pada bahagian muka depan dan belakang 

supaya lebih kemas dan tahan lebih lama.  

 
Contoh penjilidan comb 

 

 

9. Twin loop wire binding 

 Memudahkan buku dibuka secara penuh. 

 
Contoh penjilidan twin loop wire 
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6.3.7 MENCETAK DAN MELAKSANAKAN PROSES KEMASAN (FINISHING) HASIL KARYA 

AKHIR PENERBITAN 

 

PRESS 

Tahap pertama pada proses cetak ini dikenali dengan istilah Make-Ready Process 

yang meliputi:  

1. Pembuatan plat cetak 

2. Pemasangan plat ke mesin cetak 

3. Pemotongan kertas  

4. Proses pengisian kertas ke mesin cetak 

5. Pemasangan dakwat 

6. Proses penyesuaian warna hingga memperoleh kestabilan warna cetak sesuai 

piawai yang diinginkan di atas kertas seperti telah dipersetujui oleh pelanggan. 

 

POST-PRESS 

Dikenali dengan istilah proses akhir percetakan.  

Lembaran hasil cetak akan diubah ke dalam bentuk yang sesuai dengan spesifikasi 

yang telah dipersetujui oleh klien, misalnya: pemotongan hasil cetak dengan 

ukuran sebenar, proses laminasi, pond, foil, emboss serta proses jilid. 

Setelah proses ini selesai, produk akhir akan dihantar kepada pelanggan. 
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PANDUAN FORMAT FILE 

GAMBAR BITMAP 

1. JPEG: Singkatan daripada Joint Photography Expert Group. JPEG merupakan 

format fail yang dimampatkan yang umumnya digunakan dalam gambar 

fotografi. Memiliki kualiti yang lebih rendah daripada fail TIFF. 

 

2. PSD: File bitmap yang dihasilkan daripada perisian Adobe Photoshop dan 

biasanya digunakan untuk pengimejan digital kerana format ini memiliki semua 

kemudahan yang diingini dalam pengimejan digital. 

 

3. TIFF: Singkatan daripada Tagged Image File Format. Merupakan format fail 

berkualiti tinggi untuk kategori fail bitmap yang dianjurkan dalam industri cetak. 

 

4. PNG: Singkatan daripada Portable Network Graphics. Merupakan 

format fail yang dirancang untuk penggunaan fail atas talian dan memiliki 

format transparensi. Fail ini tidak sesuai untuk percetakan. 

 

5. GIF: Singkatan daripada Graphics Interchange Format. Merupakan 

format fail yang dikhaskan untuk kegunaan atas talian dan dapat digunakan 

untuk animasi. Fail ini juga memiliki format transparensi seperti .png, dengan 

kualiti yang lebih rendah. 

 

GAMBAR VEKTOR 

1. INDD: Fail dengan format ini dihasilkan daripada program Adobe In-design. 

Merupakan aplikasi terbaik untuk membuat berbagai jenis layout mulai dari 

brosur hingga buku yang memiliki banyak halaman. 

 

2. AI: Fail yang dihasilkan daripada program Adobe Illustrator. Fail ini digunakan 

khusus untuk single page, vector-based drawing yang dapat mengolah fail jenis 

.eps dan .pdf. Fungsi layer yang mirip seperti Adobe Photoshop menjadikannya 

aplikasi terbaik untuk membuat ilustrasi vektor dan perekaan logo. 

3. EPS: Singkatan daripada Encapsulated Post Script. Merupakan format piawai 

yang biasanya digunakan untuk menyimpan fail vektor, seperti logo atau 

ilustrasi vektor. Memiliki format transparensi dan sangat baik untuk mencetak 

format besar. 
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JENIS FILE GABUNGAN ANTARA BITMAP & VEKTOR 

 

 

 

1. PDF: Singkatan daripada Portable Document Format. Fail PDF juga merupakan 

gabungan antara raster dan vektor (misalnya dalam layout buku, brosur, 

risalah). Merupakan jenis fail yang digunakan sebagai piawai dalam industri 

percetakan untuk pemindahan fail melalui atas talian dan kemudahan 

menukarkan fail kepada format lain tanpa kehilangan kualiti. 

 

Tips: Untuk body text gunakan format vektor agar hasil cetakan lebih baik. Teks 

dalam bentuk vektor dapat dihasilkan melalui perisian Adobe In-design, Adobe 

Illustrator, Corel Draw dan Macromedia Freehand. 

 

 

 

  



162 
 

AKTIVITI 

BAHAN DAN PERALATAN  

1. Perisian penerbitan meja (MS Publisher) 

2. kertas A4 untuk cetakan 

3. PC dan pencetak 

 

TUGASAN  

Murid diminta untuk menghasilkan karya penerbitan meja dengan 

mengaplikasi fitur berdasarkan tema yang diberikan oleh guru. 

Murid perlu menghasilkan karya tersebut berdasarkan proses yang 

telah dipelajari dalam pembelajaran lepas. 

 

 

 

 

LANGKAH KERJA (TUGASAN) 

 

1. Murid mencari ilham berdasarkan tema yang diberikan oleh guru. 

2. Murid membuat lakaran berdasarkan ilham (lakaran kecil, lakaran kasar dan 

lakaran komprehensif) yang telah dicari dan membuat mekap contoh (mock-

up). 

3. Murid mencari gambar sumber, teks dan maklumat.  

4. Murid menyisip dan menyusun sumber dalam dokumen perisian penerbitan 

meja. 

5. Murid menghasilkan karya berdasarkan spesifikasi penerbitan meja yang telah 

dipelajari. 

 

Anda kreatif? 

Buat kajian lapangan untuk menghasilkan beberapa jenis karya 

penerbitan meja lagi. 

(i) Kad Perayaan   

       (ii) Brosur 
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LATIHAN / PENILAIAN 

 

Jawab semua soalan. 

 

1. Senaraikan 3 perisian penerbitan meja. 

i. …………………………………………… 

ii. …………………………………………… 

iii. …………………………………………… 

 

 

2. Nyatakan 3 bahagian utama dalam perisian MS Publisher. 

i. …………………………………………… 

ii. …………………………………………… 

iii. …………………………………………… 

 

 

3. Senaraikan 3 fungsi arahan pada File Menu dalam perisian MS Publisher. 

i. …………………………………………… 

ii. …………………………………………… 

iii. …………………………………………… 
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4. Senaraikan 5 kumpulan menu (Tabs) bagi fungsi alat dan fitur dalam 

perisian MS Publisher. 

i. ……………………………………………......................................................... 

ii. ....................................................................................................................... 

iii. ....................................................................................................................... 

iv. ....................................................................................................................... 

v. ....................................................................................................................... 

 

 

5. Jelaskan fungsi kumpulan fungsi alat dan fitur tersebut. 

i. Arrange: …………………………………………….................................. 

ii. Building Block: ……………………………………………......................... 

iii. Scheme: …………………………………………….................................. 
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LAPORAN PENCAPAIAN MURID 

 

Nama Murid  

Tahun  

Kelas   

 

Standard 

Kandungan 

6.3     Penghasilan karya penerbitan meja 

Standard 

Pembelajaran 

6.3.1 Menjelaskan fungsi alat dan fitur dalam perisian 

penerbitan atas meja 

6.3.2 Membuat penetapan dokumen: 

(i) Saiz halaman dan margin 

(ii) Grid dan lajur 

(iii) Halaman utama (master page) 

(iv) Palet warna 

(v) Stail perenggan  

6.3.3 Menyisip dan Menyusun teks dan imej dengan 

menggunakan alat dan fitur yang sesuai 

6.3.4 Menghasilkan karya penerbitan meja dengan 

mengaplikasikan fitur: 

(i) Pengepala dan Pengaki (Header and footer) 

(ii) Tajuk Silang dan Tajuk Samping (Crosshead and 

sidehead) 

(iii)  Pull-quote 

(iv) Pengengsotan (Indentation) 

(v) Penjajaran (Alignment) 

(vi) Wrapping  

(vii) Hyphenation  

(viii) Drop cap 

6.3.5 Menyediakan fail untuk proses prepress 

6.3.6 Mencadangkan jenis penjilidan yang bersesuaian 

dengan hasil karya penerbitan meja 

6.3.7 Mencetak dan melaksanakan proses kemasan (finishing) 

hasil karya akhir penerbitan 
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Bil Perkara yang dinilai 

Pencapaian 

Catatan 
Terampil 

Belum 

Terampil 

1. Menjelaskan fungsi alat dan fitur 

dalam perisian penerbitan atas meja 

   

2. Membuat penetapan dokumen     

3. Menyisip dan Menyusun teks dan 

imej dengan menggunakan alat 

dan fitur yang sesuai 

   

4. Menghasilkan karya penerbitan 

meja dengan mengaplikasikan fitur  

   

5. Menyediakan format fail untuk 

proses prepress 

   

6. Menyenaraikan jenis penjilidan yang 

bersesuaian dengan hasil karya 

penerbitan 

   

7. Membuat proses kemasan (finishing) 

hasil karya akhir penerbitan 

   

KEPUTUSAN 
(CAPAI / TIDAK CAPAI) 

TARIKH 

 

Nama Guru  Tandatangan & 

Tarikh 

 

Disahkan oleh  Tandatangan & 

Tarikh 
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KEPUTUSAN STANDARD PRESTASI 

 

Nama Murid  

Tahun  

Kelas  

 

Modul Reka Bentuk Penerbitan Meja (Desktop Publishing) 

Standard 

Kandungan 

6.1 Asas Penerbitan Meja 

6.2 Pengolahan Idea Karya Penerbitan Meja 

6.3 Penghasilan karya penerbitan meja 

 

Standard Prestasi Terampil 

Tahap 

Penguasaan 
Tafsiran Ya Belum 

1 
Menyatakan definisi dan jenis karya 

penerbitan meja. 

  

2 

Menterjemahkan mekap contoh (mock-

up) berdasarkan elemen dan prinsip 

rekaan grafik.  

  

3 

Menghasilkan karya penerbitan meja 

dengan mengaplikasikan terminologi 

karya penerbitan berdasarkan mekap 

contoh (mock-up).  

  

4 

Membuat analisis hasil karya penerbitan 

atas meja berdasarkan mekap contoh 

(mock-up) untuk penambahbaikan karya.  

  

5 

Menilai dan memberi justifikasi jenis 

penjilidan untuk proses kemasan (finishing) 

yang bersesuaian dengan hasil karya akhir 

penerbitan secara rasional.  

  

6 

Menghasilkan karya akhir melalui proses 

prepress dan membuat kemasan 

(finishing) karya penerbitan meja dengan 

menekankan aspek kandungan dan nilai 
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Standard Prestasi Terampil 

Tahap 

Penguasaan 
Tafsiran Ya Belum 

estetika secara beretika, sistematik, 

bermakna dan kreatif. 

 

Keputusan Tahap  

 

Nama Guru  Tandatangan & 

Tarikh 

 

Disahkan 

oleh 

 Tandatangan & 

Tarikh 
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